IBM SmartCloud Application Performance Management
Entry Edition - VM Image
Version 7 Release 7

Installation and Deployment Guide
IBM SmartCloud Application Performance Management
Entry Edition - VM Image
Version 7 Release 7

Installation and Deployment Guide

IBM
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>About this publication</strong></td>
<td>iv</td>
<td>.vii</td>
</tr>
<tr>
<td><strong>Chapter 1. Overview of IBM SmartCloud Application Performance Management Entry Edition - VM Image</strong></td>
<td>Chapter 1. Overview of IBM SmartCloud Application Performance Management Entry Edition - VM Image</td>
<td>1</td>
</tr>
<tr>
<td><strong>Chapter 2. Installing and deploying</strong></td>
<td>Chapter 2. Installing and deploying</td>
<td>11</td>
</tr>
<tr>
<td><strong>Chapter 3. Viewing monitoring data</strong></td>
<td>Chapter 3. Viewing monitoring data</td>
<td>31</td>
</tr>
<tr>
<td><strong>Chapter 4. Monitoring resources.</strong></td>
<td>Chapter 4. Monitoring resources.</td>
<td>33</td>
</tr>
<tr>
<td><strong>Chapter 5. Monitoring virtual environments</strong></td>
<td>Chapter 5. Monitoring virtual environments</td>
<td>37</td>
</tr>
<tr>
<td><strong>Chapter 6. Managing historical data collection</strong></td>
<td>Chapter 6. Managing historical data collection</td>
<td>39</td>
</tr>
<tr>
<td><strong>Chapter 7. Using Tivoli Common Reporting</strong></td>
<td>Chapter 7. Using Tivoli Common Reporting</td>
<td>43</td>
</tr>
<tr>
<td><strong>Chapter 8. Upgrading and upgrading components</strong></td>
<td>Chapter 8. Upgrading and upgrading components</td>
<td>47</td>
</tr>
<tr>
<td><strong>Chapter 9. Troubleshooting</strong></td>
<td>Chapter 9. Troubleshooting</td>
<td>53</td>
</tr>
<tr>
<td><strong>Appendix. Accessibility</strong></td>
<td>Appendix. Accessibility</td>
<td>59</td>
</tr>
</tbody>
</table>

**Glossary**

<table>
<thead>
<tr>
<th>Letter</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A.</td>
<td>61</td>
</tr>
<tr>
<td>C.</td>
<td>61</td>
</tr>
<tr>
<td>D.</td>
<td>61</td>
</tr>
<tr>
<td>E.</td>
<td>62</td>
</tr>
<tr>
<td>H.</td>
<td>62</td>
</tr>
<tr>
<td>I.</td>
<td>62</td>
</tr>
<tr>
<td>M.</td>
<td>62</td>
</tr>
<tr>
<td>P.</td>
<td>63</td>
</tr>
</tbody>
</table>
## Tables

1. Parameters for deploying the virtual machine image for Tivoli Data Warehouse and their descriptions ........................................ 13
2. Parameters for deploying the virtual machine image for IBM Tivoli Monitoring and their descriptions ........................................ 15
3. NetBIOS Reserved Ports ........................................................................... 20
About this publication


Intended audience

This publication is for those who are responsible for installing and deploying SmartCloud Application Performance Management Entry Edition - VM Image. Readers might take on the following roles:

- System administrator
- Network administrator
- IBM Support
- Field system engineers

Accessing terminology online


Accessing publications online

To access the publications using a web browser, go to the IBM SmartCloud Application Performance Management Information Center. IBM posts publications for this and all other Tivoli products, as they become available and whenever they are updated, to the Tivoli Documentation Central website at [https://www.ibm.com/developerworks/community/wikis/home/wiki/Tivoli%20Documentation%20Central](https://www.ibm.com/developerworks/community/wikis/home/wiki/Tivoli%20Documentation%20Central).

*Note:* If you print PDF documents on other than letter-sized paper, set the option in the *File > Print* window that allows Adobe Reader to print letter-sized pages on your local paper.

Ordering publications


You can also order by telephone by calling one of these numbers:

- In the United States: 800-879-2755
- In Canada: 800-426-4968

© Copyright IBM Corp. 2012, 2014
In other countries, contact your software account representative to order Tivoli publications. To locate the telephone number of your local representative, perform the following steps:

2. Select your country from the list and click Go.
3. Click About this site in the main panel to see an information page that includes the telephone number of your local representative.

### Accessibility

Accessibility features help users with a physical disability, such as restricted mobility or limited vision, to use software products successfully. With this product, you can use assistive technologies to hear and navigate the interface. You can also use the keyboard instead of the mouse to operate all features of the graphical user interface.

For additional information, see the Accessibility Appendix in *IBM SmartCloud Application Performance Management Entry Edition - VM Image: Installation and Deployment Guide*.

### Tivoli technical training

For Tivoli technical training information, see the following IBM Tivoli Education website at [http://www.ibm.com/software/tivoli/education](http://www.ibm.com/software/tivoli/education).

### Tivoli user groups

Tivoli user groups are independent, user-run membership organizations that provide Tivoli users with information to assist them in the implementation of Tivoli Software solutions. Through these groups, members can share information and learn from the knowledge and experience of other Tivoli users. Tivoli user groups include the following members and groups:

- 23,000+ members
- 144+ groups


### Support information

If you have a problem with your IBM software, you want to resolve it quickly. IBM provides the following ways for you to obtain the support you need:

**Online**


**IBM Support Assistant**

The IBM Support Assistant is a free local software serviceability workbench that helps you resolve questions and problems with IBM software products. The Support Assistant provides quick access to support-related information and serviceability tools for problem determination. To install the Support Assistant software, go to [http://www.ibm.com/software/support/isa](http://www.ibm.com/software/support/isa)
Chapter 1. Overview of IBM SmartCloud Application Performance Management Entry Edition - VM Image

IBM SmartCloud Application Performance Management Entry Edition - VM Image intelligently manages your applications in cloud and hybrid environments.

The IBM SmartCloud Application Performance Management Entry Edition - VM Image solution monitors and manages systems, application servers, and database servers. It tracks availability and performance and provides reports in a browser-based graphical user interface, to track trends and troubleshoot problems. The user interface also offers expert advice on alerts and corrective actions.

SmartCloud Application Performance Management Entry Edition - VM Image manages your applications in cloud and hybrid environments by including the following major functions:

- Includes the right visibility, control, and automation for critical applications
- Provides a single, integrated reporting analytics tool, which is based on Cognos®, makes reporting simple and easy to customize
- Avoids problems by providing visibility into the availability, performance, and content accuracy of your internet services
- Delivers breadth of domain coverage in combination with a single trusted source of information for more accurate and faster problem solving

IT operations and administrators can use the SmartCloud Application Performance Management Entry Edition - VM Image solution to maintain high performance and availability levels for their systems. By using the consolidated set of tools, IT organizations can optimize service levels and contain costs on critical application resources across the enterprise.

Contents of the offering

The SmartCloud Application Performance Management Entry Edition - VM Image is delivered as two virtual machine images and a package that contains the files for deploying monitoring agents. The two virtual machine images are named virtual machine image for Tivoli® Data Warehouse and virtual machine image for IBM Tivoli Monitoring. You can obtain the contents of the offering from IBM Passport Advantage® or from the product DVDs.

Contents of the offering are divided into the following three categories:

- Components contained in the virtual machine image for Tivoli Data Warehouse
- Components contained in the virtual machine image for IBM Tivoli Monitoring
- Agent installation images contained in separate packages

Components that are contained in the virtual machine image for Tivoli Data Warehouse:

IBM DB2® Enterprise Server Edition Version 10.1

IBM DB2 Enterprise Server Edition provides scalable database server software to handle the demanding workloads of large and midsize enterprise servers. It delivers high performance across multiple workloads,
while helping to reduce administration, storage, development and server costs. IBM DB2 Enterprise Server Edition runs on Linux, UNIX, and Windows platforms.

**IBM Tivoli Monitoring Version 6.3 Fix Pack 2**

**Tivoli Data Warehouse**

With Tivoli Data Warehouse, you can analyze historical trends from monitoring agents. The Tivoli Data Warehouse uses a DB2 for Linux, UNIX, and Windows, DB2 on z/OS®, Oracle, or Microsoft SQL Server database to store historical data that is collected across your environment. You can generate warehouse reports for short-term or long-term data through the Tivoli Enterprise Portal. Warehouse reports provide information about the availability and performance of your monitoring environment over a time. You can also use third-party warehouse reporting software, such as Crystal Reports or Brio, to generate reports.

**Warehouse Proxy Agent**

The Warehouse Proxy Agent receives data that is collected by monitoring agents and moves the data to the Tivoli Data Warehouse database.

**Summarization and Pruning Agent**

The Summarization and Pruning Agent provides the ability to customize the length of time for which to save data (pruning) and how often to aggregate granular data (summarization) in the Tivoli Data Warehouse database.

**Performance Analyzer**

IBM Tivoli Performance Analyzer adds predictive capability to Tivoli Monitoring. You can monitor resource consumption trends, anticipate future performance issues, and avoid or resolve problems more quickly. For example, you can use Tivoli Performance Analyzer, which is fully automated, to predict application bottlenecks and to create alerts for potential service threats.

**Monitoring Agent for Linux OS**

The Monitoring Agent for Linux OS is an intelligent, remote monitoring agent that resides on managed resources. It assists you in anticipating trouble and warns systems administrators when critical events take place on their systems. With the Monitoring Agent for Linux OS, systems administrators can set threshold levels and flags as wanted to be alerted when the system reaches these thresholds.

After you deploy the virtual machine image for Tivoli Data Warehouse, this agent is installed on the system where you deploy the virtual machine image, and you can see the data that is collected by the agent.

**IBM Tivoli Composite Application Manager Agent for DB2 Version 7.1**

The DB2 agent provides intelligent monitoring and management of DB2 database servers. Views show key metrics that are unique to each application, including buffer hits, connections that are used, thread activity, deadlocks, and contention.
After you deploy the virtual machine image for Tivoli Data Warehouse, this agent is installed on the system where you deploy the virtual machine image, and you can see the data that is collected by the agent.

**IBM Tivoli Common Reporting Version 3.1.0.1**

Tivoli Common Reporting provides an integrated reporting solution for the products in the Tivoli portfolio. You can link multiple reports across various IBM Tivoli products to simplify the report navigation and accelerate access to key reporting information.

**IBM SmartCloud Application Performance Management UI Version 7.7.0.0.1**

The IBM SmartCloud Application Performance Management UI provides new and customizable dashboards for IBM SmartCloud Application Performance Management, IBM Tivoli Monitoring, and IBM Tivoli Composite Application Manager products.

**IBM Tivoli Monitoring for Virtual Environments Version 7.2.0.2: Dashboard, Reporting, and Capacity Planning**

The three IBM Tivoli Monitoring for Virtual Environments components are supported through the Tivoli Integrated Portal. Tivoli Monitoring for Virtual Environments provides a comprehensive tool to monitor the availability and performance of virtual environments. In addition, Tivoli Monitoring for Virtual Environments provides performance and capacity reporting of virtual environments and helps you with capacity planning activities to optimize, consolidate, and balance the overall capacity of the virtual environments.

**Language pack**

Language packs are provided for the components that are provided by the virtual machine image for Tivoli Data Warehouse. Different components might support different national languages. For more information about the supported languages, check the component-specific documentation.

**Components that are contained in the virtual machine image for IBM Tivoli Monitoring:**

The virtual machine image for IBM Tivoli Monitoring contains the following components:

**IBM Tivoli Monitoring Version 6.3 Fix Pack 2**

IBM Tivoli Monitoring monitors and manages system and network applications on various operating systems, tracks the availability and performance of your enterprise system, and provides reports to track trends and troubleshoot problems. The following IBM Tivoli Monitoring components are included:

**Tivoli Enterprise Monitoring Server**

The Tivoli Enterprise Monitoring Server (the *monitoring server*) is the collection and control point for performance and availability data and alerts that are received from monitoring agents. It is also responsible for tracking the online or offline status of monitoring agents.

**Tivoli Enterprise Portal Server**

The Tivoli Enterprise Portal Server (the *portal server*) communicates with the hub monitoring server, which in turn controls the remote monitoring servers, and any monitoring agents that might be connected to the hub directly.
Tivoli Enterprise Portal Browser Client
The Tivoli Enterprise Portal browser client is automatically installed with Tivoli Enterprise Portal Server. The portal server manages data access through user workspace consoles (the portal clients). The portal server connects to a hub monitoring server; it retrieves data from the hub in response to user actions at a portal client, and sends the data back to the portal client for presentation. The portal server also provides presentation information to the portal client so that it can render the user interface views suitably. The browser client can be run using Microsoft Internet Explorer or Mozilla Firefox; it connects to a web server that is running in the portal server.

Monitoring Agent for Linux OS
The Monitoring Agent for Linux OS is an intelligent, remote monitoring agent that resides on managed resources. It assists you in anticipating trouble and warns systems administrators when critical events take place on their systems. With the Monitoring Agent for Linux OS, systems administrators can set threshold levels and flags as wanted to alert them when the system reaches these thresholds.

After you deploy the virtual machine image for IBM Tivoli Monitoring, this agent is installed on the system where you deploy the virtual machine image and you can see the data that is collected by the agent.

Operating system agent depots
Operating system (OS) agents monitor the availability and performance of the computers in your monitoring environment. An OS agent must reside on the computer that it is monitoring. The agent depot is an installation directory on the Tivoli Enterprise Monitoring Server from which you deploy agents and maintenance packages across your environment. With the OS agent depots, you can deploy any OS agent to the operating system that you want to monitor from the monitoring server.

Log File agent depot
The Log File agent is an agent that provides a configurable log file monitoring capability that uses regular expressions. For compatibility, the agent can consume the configuration information and format strings that are previously used by the Tivoli Event Console Log File Adapter. These strings allow the agent to filter the log data according to patterns in the format file, and submit only the interesting data to an event consumer. The agent can send data both to a Tivoli Enterprise Monitoring Server or through the Event Integration Facility (EIF) to any EIF receiver, such as the OMNIbus EIF probe.

Universal Agent depot
The Tivoli Universal Agent is a generic agent of IBM Tivoli Monitoring. You can configure the Tivoli Universal Agent to monitor any data you collect. You can view the data in real-time and historical workspaces on the Tivoli Enterprise Portal and manage with Tivoli Enterprise Portal monitoring situations and automation policies, the same as data from other Tivoli Enterprise Monitoring Agents.
Agentless monitoring
An agentless monitor is a standard Tivoli Monitoring agent that can monitor multiple operating system nodes that do not have standard OS agents running on them. An agentless monitor obtains data from nodes it is monitoring by a remote application programming interface (API) that is running on the node that is being monitored. Because these interfaces provide either operating system functions or base application functions, no IBM Tivoli Monitoring component need be installed or deployed on the monitored node.

IBM SmartCloud Application Performance Monitoring agent depots for remote deployment
Agent depots of the following components in IBM SmartCloud Application Performance Monitoring are provided for you to deploy to your environment from the monitoring server:

IBM Tivoli Composite Application Manager for Applications Version 7.2.1.1
The ITCAM for Applications offering is a package of component products that monitor and manage systems, application servers, and Database servers; track availability and performance; and provide reports, in a browser-based graphical user interface, to track trends and troubleshoot problems. The user interface also offers expert advice on alerts and corrective actions. The following ITCAM for Applications components are provided in the virtual machine image for IBM Tivoli Monitoring:

ITCAM Agent for DB2 Version 7.1
The DB2 agent provides intelligent monitoring and management of DB2 database servers. Views show key metrics that are unique to each application, including buffer hits, connections used, thread activity, deadlocks, and contention.

ITCAM Agent for HTTP Servers Version 7.1.0.3 Interim Fix 4
The HTTP Servers agent ensures the availability and performance of critical business applications and services by comprehensively monitoring the health and performance of the HTTP server. This agent alerts administrators of health and performance problems, provides real-time metrics for problem diagnosis, and collects historical metrics for reporting and capacity trending.

ITCAM Extended Agent for Oracle Database Version 6.3.1 Fix Pack 1
The Oracle agent provides intelligent monitoring and management of Oracle database servers, Oracle Real Application Clusters (RAC) database servers, Automated Storage Management (ASM) software, and Oracle Data Guard. Views display key metrics that are unique to each application, including buffer hits, connections that are used, thread activity, deadlocks, and contention.

IBM Tivoli Composite Application Manager for Microsoft Applications Version 6.3.1.1
The ITCAM for Microsoft Applications product monitors systems, applications, and transactions to speed problem determination and automate problem resolution in Microsoft environments to increase productivity while supporting cross-platform growth. The
following ITCAM for Microsoft Applications components are provided in the virtual machine image for IBM Tivoli Monitoring:

**Active Directory agent**

The Microsoft Active Directory agent offers a central point of management for your Microsoft Active Directory service. This agent provides a comprehensive means for gathering the information that you require to detect problems early and to prevent them. You can monitor many servers from a single workstation, and information is standardized across the system.

**Cluster Server agent**

The Microsoft Cluster Server agent monitors availability of cluster and cluster resources, provides the ability to generate reports for the metrics collected, provides availability monitoring for the cluster server’s key monitoring points (cluster level, cluster nodes, cluster resource groups, cluster resources and cluster networks), provides cluster resource usage across the nodes of the cluster, and reports threats in capacity availability of processor, memory, disk, and networks.

**Exchange Server agent**

The Microsoft Exchange Server agent offers a central point of management for your Microsoft Exchange Server product. This agent provides a comprehensive means for gathering the information that you require to detect problems early and to prevent them. By using this agent, you can collect and analyze information that is related to the Microsoft Exchange Server.

**Hyper-V Server agent**

The Microsoft Hyper-V Server agent monitors Microsoft Hyper-V Server, and includes the following functions: availability monitoring for Hyper-V services, provides Hyper-V configuration and virtual machine configuration information, collects applicable performance attributes, providing situations where appropriate, displays the enterprise level information for all the Hyper-V systems, provides actions to start and stop the Hyper-V systems and virtual machines, and monitors the availability of virtual machines.

**Internet Information Services agent**

The Microsoft Internet Information Services agent monitors internet information services and processes, indicating when they are down, monitors for errors and events affecting Microsoft IIS availability or performance, collects applicable performance attributes, providing situations where appropriate, provides actions to start and stop the website, FTP sites, and the several internet services, and provides the ability to generate reports for the attributes collected.

**.NET Framework agent**

The Microsoft .NET Framework agent collects performance attributes within the .NET Framework, providing situations where appropriate, monitors for errors and events affecting
the .NET Framework, provides the ability to generate reports for the attributes collected, and provides support for 32 bit and 64 bit .NET applications.

**Microsoft BizTalk Server agent**
The Microsoft BizTalk Server agent monitors and indicates when BizTalk services status is down, monitors for errors and events affecting BizTalk Server availability or performance, collects applicable performance attributes and provides situations where appropriate, provides actions to start and stop BizTalk services, and provides the ability to generate reports for the attributes collected.

**Microsoft Host Integration Server agent**
The Microsoft Host Integration Server agent monitors and displays information that is related to Microsoft Host Integration Servers and BizTalk Adapters for Host Systems.

**Microsoft Lync Server agent**
Monitors Microsoft Lync Server 2007, 2007 R2, and 2010. This monitoring agent monitors functional components of the Microsoft Lync Server, such as instance messaging, text conferencing, audio and video conferencing, and web conferencing. It also generates situational alerts and provides suggestions for triggered situations.

**SharePoint Server agent**
The Microsoft SharePoint Server agent monitors SharePoint Server services, indicating when they are down, monitors for SharePoint event sources affecting SharePoint Server availability or performance, collects applicable performance attributes, providing situations where appropriate, provides start and stop functions for SharePoint services, and provides the ability to generate reports for the attributes collected.

**SQL Server agent**
The Microsoft SQL Server agent offers a central point of management for distributed databases. This agent provides a comprehensive means for gathering the information that you require to detect problems early and prevent them. Information is standardized across all systems. You can monitor hundreds of servers from a single workstation. You can collect and then analyze specific information by using the Tivoli Enterprise Portal.

**IBM Tivoli Composite Application Manager for Transactions Version 7.4**
The ITCAM for Transactions product delivers a comprehensive, unified transaction tracking management system that runs on a single, consolidated infrastructure with a tightly integrated user interface. The following ITCAM for Transactions components are provided in the virtual machine image for IBM Tivoli Monitoring:

**Internet Service Monitoring**
The information gathered and processed by Internet Service Monitoring can be used to determine whether a particular service is performing adequately, identify problem areas, report service performance measured against Service Level Agreements (SLAs), and forward
performance data to IBM Tivoli Monitoring, IBM Tivoli Composite Application Manager for Transactions, and other event management tools such as IBM Tivoli Netcool/OMNibus.

**Application Management Console**
The Application Management Console agent provides an accurate snapshot of ITCAM for Transactions monitoring in near real time. It provides real-time aggregated and consolidated application and transaction availability and response time information for all applications that are monitored by Internet Services, Response Time, and Transaction Tracking monitoring agents. It collects data in real time at a configurable, constant interval instead of relying on the Tivoli Data Warehouse. Use the Application Management Console agent to see status summary and trend analysis information across managed resources and to perform problem determination. This information is displayed on the Tivoli Enterprise Portal.

After you deploy the virtual machine image for IBM Tivoli Monitoring, this agent is installed on the system where you deploy the virtual machine image and you can see the data that is collected by the agent.

**Web Response Time agent**
The Web Response Time agent provides user monitoring of client web requests to server components. It can be installed locally on the server system, or on a separate system. The Web Response Time agent uses server-side monitoring to capture HTTP and HTTPS transaction data such as response time and status codes. You can use this agent to capture the performance and availability data of actual users for Service Level Agreement (SLA) reporting. Web Response Time also detects protocols and applications by monitoring TCP/IP network flows.

**IBM Tivoli Monitoring for Virtual Environments Version 7.2.0.2**
The IBM Tivoli Monitoring for Virtual Environments helps you identify and resolve virtual server availability and performance issues.

**IBM Tivoli Monitoring for Virtual Environments Agent for Linux Kernel-based Virtual Machines**
Remote performance and availability monitoring to visualize availability, performance, and capacity trends for Kernel-based Virtual Machines (KVM) and hosts. This agent remotely monitors KVM by connecting to each host.

**IBM Tivoli Monitoring for Virtual Environments Agent for VMware VI**
This VMware VI agent provides you with the capability to monitor a VMware environment and to provide basic actions with VMware Virtual Centers.

**Network Devices agent**
The Network Devices agent offers a central point of management for your network devices environment or application. This agent provides a comprehensive means
for gathering the information that you require to detect problems early and to prevent them. Information is standardized across the system. You can monitor multiple servers from a single workstation. By using the Network Devices agent, you can collect and analyze network devices-specific information.

Language pack
Language packs are provided for the components that are provided by the virtual machine image for IBM Tivoli Monitoring. Different components might support different national languages. For more information about the supported languages, check the component-specific documentation.

Agent installation images that are contained in separate packages:

Some agent installation images are included in separate packages instead of the virtual machine images. If the agent supports remote deployment, its installation image for remote deployment is included in the package. If the agent does not support remote deployment, its full installation image is included.

Agent installation images for remote deployment
The following agents support remote deployment. Their installation images for remote deployment are included in separate packages. If you want to deploy these agents in your environment to monitor applications, you must first upload the agent installation images to the server on which you deploy the virtual machine image for IBM Tivoli Monitoring. For detailed instructions about how to remotely deploy an agent, see the IBM SmartCloud Application Performance Management Entry Edition - VM Image: Installation and Deployment Guide

ITCAM Agent for Lotus® Domino® Version 6.2.1
The Lotus Domino agent provides secure monitoring and management of Lotus Domino servers, helping to optimize the performance of the Lotus Domino application. The provided function uses best practice models that focus on server availability, database management, mail routing, replication, server processes, and server health.

ITCAM Agent for Sybase ASE Version 6.2
The Sybase ASE agent provides intelligent monitoring and management of Sybase servers. Views display key metrics that are unique to each application, including buffer hits, connections that are used, thread activity, deadlocks, and contention.

IBM Tivoli Monitoring for Virtual Environments Version 7.2.0.2: NetApp Storage Agent
The NetApp Storage agent provides you with the capability to monitor NetApp and IBM N Series storage systems through NetApp DataFabric Manager (DFM). IBM Tivoli Monitoring is the base software for the NetApp Storage agent.

Full installation images for the following components
The following components do not support remote deployment. If you want to deploy these agents in your environment to monitor applications, you must first upload the agent installation images to the managed system. For detailed instructions about how to upload the agent installation images to a managed system, see the IBM SmartCloud Application Performance Management Entry Edition - VM Image: Installation and Deployment Guide.
The installation images for the following components are provided for you to install them locally on the managed systems.

**IBM Tivoli Monitoring Version 6.3 Fix Pack 2: Monitoring Agent for IBM i OS**

The Monitoring Agent for IBM i OS offers a central point of management for IBM i OS systems. It provides a comprehensive means for gathering the information that you require to detect problems early and prevent them. Information is standardized across all distributed systems. You can monitor and manage hundreds of servers from a single workstation.

**IBM Tivoli Monitoring Version 6.3 Fix Pack 2: Agent Builder**

Tivoli Monitoring Agent Builder is a set of tools that are used for creating agents, installation packages for the created agents, and application support extensions for existing agents.

**IBM Tivoli Composite Application Manager for Microsoft Applications Version 6.3.1.1: .NET Data Collector**

The .NET Data Collector can help you to track the transactions that occur in the .NET Framework application and the Internet Information Services (IIS) web applications.

---

**SmartCloud Application Performance Management community on Service Management Connect**

Connect, learn, and share with Service Management professionals: product support technical experts who provide their perspectives and expertise.


- Become involved with transparent development, an ongoing, open engagement between other users and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product roadmaps, and prerelease code.
- Connect one-on-one with the experts to collaborate and network about Tivoli and the SmartCloud Application Performance Management community.
- Read blogs to benefit from the expertise and experience of others.
- Use wikis and forums to collaborate with the broader user community.
Chapter 2. Installling and deployng

Before you can view performance and availability data for your systems, you must install and deploy SmartCloud Application Performance Management Entry Edition - VM Image in your environment.

About this task

To get started with SmartCloud Application Performance Management Entry Edition - VM Image quickly, complete the checklists in the Planning and deployment checklists section of the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide on Service Management Connect.

Review the following procedures, which describe the general process of installing and deploying SmartCloud Application Performance Management Entry Edition - VM Image in your environment:

Procedure

1. Check the hardware and software requirements to ensure that your environment meets the minimum requirements:
   - Hardware requirements
   - Software requirements


3. Use the checklists in the reference guide to record the information that you use during the deployment.

4. Deploy the virtual machine image for Tivoli Data Warehouse. See “Deploying the virtual machine image for Tivoli Data Warehouse” on page 12.

5. Deploy the virtual machine image for IBM Tivoli Monitoring. See “Deploying the virtual machine image for IBM Tivoli Monitoring” on page 14.

6. Verify that the virtual machine images are deployed successfully. See “Verifying the deployments” on page 16.

7. Get familiar with the Launch Pad. Launch Pad is the first workspace that you see after you log on to Tivoli Enterprise Portal. See “Launch Pad” on page 17 for more information.

8. Deploy an OS monitoring agent on the computer that hosts the application that you want to monitor. See “Deploying an OS monitoring agent” on page 21.


11. If you change the Tivoli Enterprise Portal logon user ID and password after deployment, you must update the file that saves the logon credentials by using the Launch Pad. Otherwise, the deployment of OS monitoring agents
Deployment sequence

Because of the dependencies that exist between some components that are included in SmartCloud Application Performance Management Entry Edition - VM Image, the virtual machine images of SmartCloud Application Performance Management Entry Edition - VM Image must be deployed in a specific sequence.

The following deployment sequence is required for SmartCloud Application Performance Management Entry Edition - VM Image:
1. The virtual machine image for Tivoli Data Warehouse
2. The virtual machine image for IBM Tivoli Monitoring

Deploying the virtual machine image for Tivoli Data Warehouse

Deploying the virtual machine image for Tivoli Data Warehouse is a required step for installing SmartCloud Application Performance Management Entry Edition - VM Image.

About this task

You must deploy the virtual machine image for Tivoli Data Warehouse before you deploy the virtual machine image for IBM Tivoli Monitoring. Otherwise, some components might not function properly.

Procedure

1. Start the VMware vSphere Client and connect to the vSphere Server.
2. Click File > Deploy OVF Template. A deployment wizard is displayed.
3. In the Deploy from a file field, type the absolute path and file name of the OVF file for the virtual machine image for Tivoli Data Warehouse, and then click Next. You can also click Browse to locate the OVF file for the virtual machine image for Tivoli Data Warehouse. The OVF file for the virtual machine image for Tivoli Data Warehouse is SAPM_EE_TDW.ovf. Detailed information about the virtual machine image is displayed.
4. Verify the information about the virtual machine image and then click Next.
5. Click Accept to accept the license agreement and then click Next.
6. In the Name field, specify a name for the virtual machine that you create, in the Inventory Location field, select an inventory location, and then click Next.
7. Select the host or cluster on which you want the virtual machine to run and then click Next.
8. Select the datastore to which you want to store the virtual machine files and then click Next.
9. Select the disk format for the virtual disks that are created to store the virtual machine and then click Next.
10. Customize the software solution for this deployment. The following parameters are required:
<table>
<thead>
<tr>
<th>Section</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default locale configuration</td>
<td>(*) Default locale</td>
<td>Default locale setting for the guest operating system that runs on the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>(*) Default country</td>
<td>Default country of the guest operating system that runs on the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>(*) Default encoding</td>
<td>Default encoding of the guest operating system that runs on the virtual machine.</td>
</tr>
<tr>
<td>System Network Configuration</td>
<td>(*) Hostname</td>
<td>Host name of the virtual machine. Do not use the fully qualified host name. For example, use myhost instead of myhost.example.com.</td>
</tr>
<tr>
<td></td>
<td>Domain</td>
<td>The fully qualified domain name (FQDN) of the virtual machine, for example, for the virtual machine myhost.example.com, its domain name is example.com.</td>
</tr>
<tr>
<td></td>
<td>(*) IP address</td>
<td>IP address of the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>(*) Net Mask</td>
<td>Specify which portion of the IP address specifies the subnetwork number and which portion specifies the host. In most networks, the value is 255.255.255.0.</td>
</tr>
<tr>
<td></td>
<td>(*) Gateway</td>
<td>Gateway of the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Primary DNS</td>
<td>Primary DNS for the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Secondary DNS</td>
<td>Secondary DNS for the virtual machine.</td>
</tr>
<tr>
<td>Root Password Configuration</td>
<td>(*) Password (root)</td>
<td>Password for the root user ID.</td>
</tr>
<tr>
<td>Virtuser Password Configuration</td>
<td>(*) Password (virtuser)</td>
<td>Password for the system user ID virtuser.</td>
</tr>
<tr>
<td>Tivoli Data Warehouse</td>
<td>(*) IP Address of the IBM Tivoli Monitoring virtual machine</td>
<td>IP address of the virtual machine on which you plan to deploy the virtual machine image for IBM Tivoli Monitoring.</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tivoli Integrated Portal</td>
<td>(*) Password of sysadmin</td>
<td>Password of the sysadmin user ID. The sysadmin user ID and its password are used later to configure Tivoli Integrated Portal data provider.</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 1. Parameters for deploying the virtual machine image for Tivoli Data Warehouse and their descriptions
Table 1. Parameters for deploying the virtual machine image for Tivoli Data Warehouse and their descriptions (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>

* denotes a required field.

11. Verify the information that you provided in the previous step and then click Finish to start the deployment.

**Results**

After the deployment task is completed, a new entry for the Tivoli Data Warehouse virtual machine is displayed in the Hosts and Clusters view for the host that was selected.

**What to do next**

To turn on the virtual machine, right-click the new entry for the Tivoli Data Warehouse virtual machine and then click Power > Power On.

**Tip:** A best practice is to create a snapshot of the virtual machine regularly. Before you create a snapshot, you can use the provided scripts to stop all services. For detailed information about the provided scripts to stop or start all services, see the Starting and stopping components on a virtual machine section in the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide.

---

**Deploying the virtual machine image for IBM Tivoli Monitoring**

Deploying the virtual machine image for IBM Tivoli Monitoring is a required step for installing SmartCloud Application Performance Management Entry Edition - VM Image.

**Before you begin**

You must deploy the virtual machine image for Tivoli Data Warehouse before you deploy the virtual machine image for IBM Tivoli Monitoring. Otherwise, some components might not function properly. See “Deploying the virtual machine image for Tivoli Data Warehouse” on page 12 for information about how to deploy the virtual machine image for Tivoli Data Warehouse.

**Procedure**

1. Start the VMware vSphere Client and connect to the vSphere Server.
2. Click File > Deploy OVF Template. A deployment wizard is displayed.
3. In the Deploy from a file field, type the absolute path and file name of the OVF file for the virtual machine image for IBM Tivoli Monitoring and then click Next. You can also click Browse to locate the OVF file. The OVF file for the virtual machine image for IBM Tivoli Monitoring is $APM_EE_ITM.ovf. Detailed information about the virtual machine image for IBM Tivoli Monitoring is displayed.
4. Verify the information about the virtual machine image for IBM Tivoli Monitoring and then click Next.
5. Click Accept to accept the license agreement and then click Next.
6. In the **Name** field, specify a name for the virtual machine that you are creating, in the **Inventory Location** field, specify an inventory location, and then click **Next**.

7. Select the host or cluster on which you want the virtual machine to run and then click **Next**.

8. Select the datastore to which you want to store the virtual machine files and then click **Next**.

9. Select the disk format for the virtual disks that are created to store the virtual machine and then click **Next**.

10. Customize the software solution for this deployment. The following parameters are required:

    **Table 2. Parameters for deploying the virtual machine image for IBM Tivoli Monitoring and their descriptions.**

<table>
<thead>
<tr>
<th>Section</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default locale configuration</td>
<td>(*) Default locale</td>
<td>Default locale setting for the guest operating system that runs on the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>(*) Default country</td>
<td>Default country of the guest operating system that runs on the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>(*) Default encoding</td>
<td>Default encoding of the guest operating system that runs on the virtual machine.</td>
</tr>
<tr>
<td>System Network Configuration</td>
<td>(*) Hostname</td>
<td>Host name of the virtual machine. Do not use the fully qualified host name. For example, use myhost instead of myhost.example.com.</td>
</tr>
<tr>
<td></td>
<td>(*) Domain</td>
<td>The fully qualified domain name (FQDN) of the virtual machine, for example, for the virtual machine myhost.example.com, its domain name is example.com.</td>
</tr>
<tr>
<td></td>
<td>(*) IP address</td>
<td>IP address of the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>(*) Net Mask</td>
<td>Specify which portion of the IP address specifies the subnetwork number and which portion specifies the host. In most networks, the value is 255.255.255.0.</td>
</tr>
<tr>
<td></td>
<td>(*) Gateway</td>
<td>Gateway of the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Primary DNS</td>
<td>Primary DNS for the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>Secondary DNS</td>
<td>Secondary DNS for the virtual machine.</td>
</tr>
<tr>
<td>Root Password Configuration</td>
<td>(*) Password (root)</td>
<td>Password for the root user ID.</td>
</tr>
</tbody>
</table>
Table 2. Parameters for deploying the virtual machine image for IBM Tivoli Monitoring and their descriptions. (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtuser Password Configuration</td>
<td>(*) Password (virtuser)</td>
<td>Password for the system user ID virtuser.</td>
</tr>
<tr>
<td>IBM Tivoli Monitoring Configuration</td>
<td>(*) IP address of the Tivoli Data Warehouse virtual machine</td>
<td>IP address of the virtual machine on which you deploy the virtual machine image for Tivoli Data Warehouse.</td>
</tr>
<tr>
<td></td>
<td>(*) Password of sysadmin</td>
<td>Password of the sysadmin user ID. You use later the sysadmin user ID to access the user interface of SmartCloud Application Performance Management Entry Edition - VM Image and view the performance and availability data of your environment.</td>
</tr>
</tbody>
</table>

* denotes a required field.

**Important:** Ensure that you can access the virtual machine by the host name that you specify in the IP address field. Otherwise, you might have problems with the Launch Pad because it is bound with the host.

11. Verify the information that you provided in the previous step and then click Finish to start the deployment.

**Results**

After the deployment task is complete, a new entry for the IBM Tivoli Monitoring virtual machine is displayed in the Hosts and Clusters view for the host that was selected.

**What to do next**

Ensure that the virtual machine for Tivoli Data Warehouse is powered on. Then, right-click the new entry for the IBM Tivoli Monitoring virtual machine and click **Power > Power On** to power on the virtual machine for IBM Tivoli Monitoring.

**Tip:** A best practice is to create a snapshot of the virtual machine regularly. Before you create a snapshot, you can use the provided scripts to stop all services. For detailed information about the provided scripts to stop or start all services, see the Starting and stopping components on a virtual machine section in the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide.

**Verifying the deployments**

After you deploy the virtual machine images and power on the virtual machines, verify their deployments. Ensure that the components contained in the virtual machine images function properly.
Before you begin

Wait for about 10 minutes after you power on the virtual machine for IBM Tivoli Monitoring because the power-on process might take 10 minutes.

Procedure

1. Open a web browser and go to http://itm_vm_hostname:1920, whereitm_vm_hostname is the fully qualified host name or IP address of the virtual machine to which the virtual machine image for IBM Tivoli Monitoring is deployed.
2. Click IBM Tivoli Enterprise Portal Web Client.
3. Use sysadmin as the user ID and its associated password to log on to Tivoli Enterprise Portal.

Results

The Launch Pad is displayed.

Launch Pad

The Launch Pad is the first workspace that you see after you log on to Tivoli Enterprise Portal. From the Launch Pad, you can access multiple workspaces to do different operational tasks or administrative tasks.

The Launch Pad serves as the starting point for completing operational and administrative tasks. From the Launch Pad, you can access multiple workspaces, from which you monitor resources and view collected real-time and historical data. Links in the Launch Pad are organized by tasks. You can select Operational Tasks or Administrative Tasks.

Manage Events

The views in this workspace present an overview of the situation events in your monitored environment and the situation status. Also, the Situation Event Console view lists the open events and the event severity.

View System Availability and Performance

This workspace lists the monitored operating systems in your network that are grouped by platform and shows the status of each operating system. To get the detailed performance data for that system, click the link indicator next to an online system.

View Application Availability and Performance

This workspace contains tables that list the monitored applications grouped by platform. Clicking the link indicator next to an application takes you to a set of workspaces that provide detailed performance data for that application.
View and Manage Reports and Dashboards
This workspace provides the access to the Tivoli Integrated Portal interface. From there, you can do the following tasks:

- Run and schedule historical reports on the data that is collected from your monitored resources and the data that is stored in the Tivoli Data Warehouse.
- View IBM Tivoli Monitoring for Virtual Environments: Dashboard, Reporting, and Capacity Planning.

Manage Situations
In this workspace, you can see the status and descriptions of all the monitoring situations that are included with the SmartCloud Application Performance Management Entry Edition - VM Image.

Maintain Appliance
From this workspace, you can upgrade a component of SmartCloud Application Performance Management Entry Edition - VM Image, collect log files of IBM Tivoli Monitoring, and get support information. See “Roadmap for upgrading a monitoring agent” on page 47 for information about how to upgrade a component.

Monitor Warehouse Agent Configuration
From this workspace, you can access information about the connectivity and configuration of the Warehouse Proxy Agent. The Warehouse Proxy Agent transfers data that is collected by monitoring agents to the Tivoli Data Warehouse, and the Summarization and Pruning Agent. The Summarization and Pruning Agent manages the data that is stored in the warehouse.

Deploy Application Monitoring
This workspace lists all the computers on which an OS monitoring agent is deployed. Clicking the link indicator next to a computer name displays the navigator entry for that computer in the Physical Navigator view. You can then click the entry and select Add Managed System to select an application monitoring agent to deploy.

Discover Systems and Deploy OS Monitoring
From this workspace, you can start the discovery process of computers in your environment and deploy OS monitoring to the operating systems.
Prerequisites

Some specific requirements must be met before the Launch Pad can deploy an OS agent, especially on Windows target systems. Review the following requirements carefully and make sure that those items that are specific to your environment are met.

- Any computer to which you want to deploy the OS agent must have a supported protocol installed. The supported protocols include SMB, SSH, REXEC, and RSH.
- Security in your environment must be configured to allow IBM Tivoli Monitoring server deployment command to pass through the firewall.
- On Windows computers, the following requirements must be met:
  - The user ID that you specify must have administrator privileges on the target computer.
  - SMB requires that the default, hidden, and administrative shares be available on the drive that is being accessed and on the drive that hosts the system temporary directory.
  - SMB signing is not supported when connecting with SMB. The computer to which you are deploying an OS agent cannot require SMB signing.
  - For all Windows computers, enable remote registry administration. (Remote registry administration is enabled by default.)
  - For Windows XP, disable Simple File Sharing. Simple File Sharing requires that all users authenticate with guest privileges, which the `tacmd createNode` command does not support. To disable Simple File Sharing, complete the following steps:
    1. Open the Windows Explorer.
    2. Click Tools > Folder Options.
    3. Click the View tab.
    4. Scroll through the list of settings to Use Simple File Sharing.
    5. Clear the check box next to Use Simple File Sharing and click OK.
  - For Windows XP computers with Service Pack 2, disable the Internet Connection Firewall.
  - For Windows XP computers, set Network Access Sharing and Security to "Classic - local users authenticate as themselves". Use the following steps:
    1. From the Control Panel, double-click Administrative Tools.
    2. Double-click Local Security Policy.
    4. Right-click Network access: Sharing and security for local accounts and click Properties.
    5. Select Classic - local users authenticate as themselves from the list and click OK.
  - Some Remote Execution and Access (RXA) operations rely on VBScript and Windows Management Instrumentation (WMI) calls to run scripts on Windows targets. If the Windows Scripting Host (WSH) or the WMI service is disabled on the target, or if VBScript is otherwise disabled, some Windows protocol methods do not work.
  - For Windows targets, IBM Tivoli Monitoring usually uses the SMB protocol over NetBIOS, so the port 139 must not be blocked by firewalls or IP security policies. The Enable NetBIOS over TCP/IP must also be selected in the Control Panel settings for the computer’s network connections properties.
(Control Panel > Network and Dial-Up Connections > <some connections> > Properties > Internet Protocol (TCP/IP) > Advanced > WINS > Enable NetBIOS over TCP/IP). Consult the documentation for your firewall to determine that these ports are not blocked for inbound requests.

To determine whether security policies are blocking these ports, click **Start > Settings > Control Panel > Administrative Tools.** Depending on whether your policies are stored locally or in Active Directory, the next steps are as follows:

- Policies that are stored in Active Directory: **Administrative Tools > Default Domain Security Settings > > IP Security Policies on Active Directory.**

Examine the IP security policies and edit or remove filters that block the ports that are listed previously. Table 3 lists the ports that are reserved for NetBIOS. Ensure that all ports currently used by RXA are not blocked.

**Table 3. NetBIOS Reserved Ports**

<table>
<thead>
<tr>
<th>Port number</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>135</td>
<td>NetBIOS Remote procedure call. Currently, RXA does not use this port.</td>
</tr>
<tr>
<td>137</td>
<td>NetBIOS name service.</td>
</tr>
<tr>
<td>138</td>
<td>NetBIOS datagram. Currently, RXA does not use this port.</td>
</tr>
<tr>
<td>139</td>
<td>NetBIOS session (file/print sharing).</td>
</tr>
<tr>
<td>445</td>
<td>CIFS (On XP and Win2K).</td>
</tr>
</tbody>
</table>

- The target computer must have the Remote Registry service started (which is the default configuration) in order for RXA to connect to the target machine.
- RXA requires access to the hidden remote administrative disk share for access to the system %TEMP% and other directories. Access to the Interprocess Communications share (IPC$) is also required for RXA to access remote registries. Before you access the Interprocess Communications share (IPC$), make sure that the Server service is started (**Control Panel > Administrative Tools > Services > Server**).

- On UNIX and Linux computers, the following requirements must be met:
  - You must specify the root user ID to deploy and OS agent.
  - If you are deploying the OS agent to a UNIX or Linux computer, that computer must have the ksh shell. Only the Korn shell is supported for the execution of the installation and runtime scripts.
  - If you are using SSH V2, configure SSH on the target computers to allow the use of password authentication. To allow the use of password authentication, do the following steps:
    1. Open the /etc/ss/sshd_config file on the target computer.
    2. Locate the line and change no to yes.
       ```bash
       PasswordAuthentication no
       ```
    3. Save the file and restart the daemon.

**Exception:** If you are using private key authentication in your environment, you do not have to set SSH to allow password authentication.
Deploying an OS monitoring agent

If you want to monitor an application, you must first deploy an OS monitoring agent on the computer that hosts the application. In addition to monitoring base OS performance, the OS agent also installs the required infrastructure for remote deployment and maintenance.

Procedure

1. Check the prerequisites and make sure that all the requirements are met in the environment. For detailed information, see “Prerequisites” on page 19.
2. Discover the computers and operating systems in your environment. For instructions, see “Discovering systems.”
3. Deploy the OS agent on the target system that hosts the application to be monitored. For instructions, see “Deploying an OS monitoring agent from the Launch Pad” on page 23.

Discovering systems

Use the discovery process to identify computers, operating systems, and network devices so that the appliance administrator can deploy the appropriate operating systems to these systems. You must run the discovery process before you can deploy monitoring for operating systems.

About this task

The discovery process can take anywhere from seconds to hours, depending on the range of IP addresses that you specify. For the discovery process to be more efficient, you can divide the IP address range into multiple segments and run the discovery process multiple times. You can continue to use the appliance while discovery is in progress and then return to the Deploy Monitoring workspace to begin deployment.

Important: Only one discovery can be running at a time. When a discovery is started, the discovery button is disabled. The discovery status icon is changed from the triangle icon to the two vertical bars icon for all users until after the initial discovery finishes.

Procedure

1. On the Launch Pad, click Discover Systems and Deploy OS Monitoring. The Deploy Monitoring workspace is displayed.
2. In the IP addresses to scan field, enter a range of IP addresses for the computers that you want to discover, in the form of n.n.n.n-n, where n is a 1 - 3 digit number, for example, 192.168.1.1-23. You can also use a mask, in the form of n.n.n.n/x, where x is the mask.
3. Click Discover. The Deploy Agents workspace is displayed. You can continue to use the appliance when the discovery is in progress.
Results

After the discovery process is completed, the results are displayed in the Discovered Systems table. For more information about interpreting the table, see "Discovery results."

What to do next

For the discovered operating systems of the following types, you can use this discovery workspace to deploy monitoring:

- Windows
- Linux
- UNIX
- HP_UX
- AIX®
- Solaris

For other operating systems, you must manually install the specific monitoring agent on the target system.

Discovery results

By default, the list of discovered resources displays all computers and devices. You can filter the results by clicking the buttons above the table to limit the list to a particular type of operating system type or to only network devices. You can also sort the results on any of the columns by clicking the corresponding column heading.

The discovery result table, as shown in Figure 1, provides the following information for each discovered resource:

- The name of the target host computer
- The IP address of the host
- The type and version of operating system on the host
The discovery process might return several possibilities of operating system type and version for a target system. The most possible OS type and versions are displayed.

Various operating system types are displayed, but you use the discovery workspace to deploy monitoring to the target systems of the following types only.

- Windows
- Linux
- UNIX
- HP_UX
- AIX
- Solaris

To deploy monitoring to the operating systems of other types, such as Tru64, i5_OS, and z_OS, you must install the specific monitoring agent manually on the target system.

The OS type of Unknown is returned when the discovery process cannot determine whether a target system is one of the previously mentioned OS types. A target system might be a valid OS type but be returned as Unknown. For example, a target system with most of the network ports closed might be reported as Unknown.

The possibility of the OS version that is discovered is in the range of 0 - 100%. When the possibility is less than 100%, confirm the operating system version before you deploy monitoring.

If the system is a network device or if the host on which OS monitoring is deployed does not have a host name that is known to the discovery process (that is, an IP address is shown as the host name), N/A is displayed in the Managed status column.

To cancel the discovery, click Cancel Discovery under the Discovered Systems table. The discovery process is stopped. The screen is refreshed. The discovery process indicator indicates that the process is idle.

**Deploying an OS monitoring agent from the Launch Pad**

After the target system is discovered and all the prerequisites are met, you can deploy the OS agent from the Launch Pad.

**Procedure**

1. On the Launch Pad, click Discover Systems and Deploy OS Monitoring. The Deploy Monitoring workspace is displayed.
2. In the Deploy section, select the computer to which you want to deploy an OS agent from the list of discovered systems and then click Deploy OS agent. The Deploy Base Agent window is displayed.
3. Enter the following information in the Deploy Base Agent window and then click OK.

**User ID**

The user ID must have administrative authorities on the target system (for example, Administrator on a Windows system or root on a Linux or UNIX system).
Password
The password that is associated with the user ID.

Install path
The directory where you want to install the OS monitoring agent.

Results
The deployment takes approximately 10 minutes. After the deployment task is completed, the value in the Managed column for the selected operating system is changed to Yes. When the deployment is in progress, you can click Deployment Status to monitor the progress of the deployment in the Deploy Status Summary workspace.

Deploying monitoring for applications
You must deploy monitoring for applications before you can view monitoring data for them.

Before you begin
You must first deploy an OS monitoring agent on the computer that hosts the application that you want to monitor. See “Deploying an OS monitoring agent” on page 21 for information about how to deploy an OS monitoring agent.

About this task
You can deploy monitoring for the following applications:
• Databases: DB2, Oracle, Sybase ASE, SQL Server,
• Email servers: Lotus Domino
• Web servers: Internet Information Services, HTTP Server
• Virtual Environment: VMware Virtual Center, Network Device, Linux Kernel-based Virtual Machines, NetApp Storage
• Transactions: Web Response Time, Internet Service Monitoring
• Log files

Procedure
1. Check the Agent installation images contained in the virtual machine image for IBM Tivoli Monitoring section of the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide to see if the agent that you want to deploy is listed in the table. Also, check if the computer to which you deploy the agent runs one of the supported operating systems.
   • If the agent is listed in the table and the operating system is supported, deploy the agent. See “Deploying a monitoring agent remotely” on page 27 for information about how to deploy an agent.
   • If the agent is listed in the table, but the operating system is not supported, go to step 2
   • If the agent is not listed in the table, go to step 2
2. Check the Agent installation images contained in separate packages section of the SmartCloud Application Performance Management Entry Edition - VM Image...
Image version 7.7 reference guide to see if the agent that you want to deploy is listed in the table. Also, check if the computer to which you deploy the agents runs one of the supported operating systems.

- If the agent is listed in the table and the operating system is supported, do the following tasks:
  - Prepare agent installation images. If you completed this task, you can skip this step. See “Preparing agent installation images” for instructions about how to prepare agent installation images.
  - Upload the agent installation images to the computer on which the virtual machine image for IBM Tivoli Monitoring is deployed. If you completed this task before, you can skip this step. See “Uploading agent installation images” on page 27 for information about how to upload agent installation images.
  - Deploy the agent. See “Deploying a monitoring agent remotely” on page 27.

- If the agent is listed in the table, but the operating system is not supported, SmartCloud Application Performance Management Entry Edition - VM Image does not support monitoring of the application on the operating system yet.

- If the agent is not listed in the table, go to step 3.

3. Check the Agent installation images contained in separate packages section of the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide to see if the agent that you want to deploy is listed in the table:

- If the agent is listed in the table, do the following steps:
  a. Follow the instructions in “Preparing agent installation images” to obtain the installation images for these components.
  b. Follow the instructions of their specific user’s guide or installation and configuration guide for installation.
     - IBM i OS Agent Installation and Configuration Guide
     - Agent Builder User’s Guide
     - .NET Data Collector Installation and Configuration Guide

- If the agent is not listed there, SmartCloud Application Performance Management Entry Edition - VM Image does not support monitoring of the application yet.

Preparation of agent installation images

This task is required only when the installation image of the agent that you want to deploy is not included in the virtual machine image for IBM Tivoli Monitoring.

Before you begin

The following procedure requires a computer that has at least 24 GB of free disk space.

About this task

If the agent that you want to deploy is listed in the Agent installation images contained in separate packages section of the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide, prepare the agent installation images before you deploy the agent.
Procedure

1. On the computer with the required free disk space, create a directory to receive the agent installation image files.

2. Copy the following files from the product DVDs or download them from the Passport Advantage website into the directory that you created in the previous step.
   - SCAPM_EE_1of3_V770_Extended_Images.part
   - SCAPM_EE_2of3_V770_Extended_Images.part
   - SCAPM_EE_3of3_V770_Extended_Images.part

3. Run the following command to merge the split files into the complete compressed file:
   - Windows systems: `copy /b f1.part+f2.part+f3.part SCAPM_EE_V770_Extended.zip`, where f1, f2, and f3 refer to the names of the files in the directory. Be sure to specify the file names in numerical order so that they are concatenated in the correct order.
   - Other platforms: `cat SCAPM*.part >> SCAPM_EE_V770_EXTENDED_IMAGES.zip`

4. Confirm that the compressed file is assembled correctly by verifying its checksum values:
   a. Run the following command to generate the checksum values for the compressed file: `md5sum -b SCAPM_EE_V770_EXTENDED_IMAGES.zip`
   b. Compare the generated checksum values with the values in the provided MD5SUMS text file.

5. Decompress the SCAPM_EE_V770_EXTENDED_IMAGES.zip file.

Results

The following files are created:
- a4520cma.sav, which contains full installation image for the Monitoring Agent for IBM i OS.
- ITM_V6.3.0_ABL.S.tar, which contains full installation image for the Agent Builder.
- ITM_V6.3.0_AB_ENGLISH_MP.tar, which contains language packs for the Agent Builder.
- QAV6311_DVD_201401150419.tar.gz, which contains full installation image for the .NET Data Collector.
- SCAPM_EE_V770_depot.tar, which contains agent installation images for the agents that are listed in the Agent installation images contained in separate packages section of the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide. You use the SCAPM_EE_V770_depot.tar file later to remotely deploy an agent that is listed in the Agent installation images contained in separate packages section of the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide.

What to do next

“Uploading agent installation images” on page 27
Uploading agent installation images

If the installation image of an agent is not included in the virtual machine image for IBM Tivoli Monitoring, you must upload its installation image to the computer on which the virtual machine image for IBM Tivoli Monitoring is deployed before you can deploy the agent.

Before you begin

Prepare the agent installation images. The required SCAPM_EE_V770_depot.tar file is created during this process. See "Preparing agent installation images" on page 25 for instructions about how to prepare the agent installation images.

Procedure

1. Upload the SCAPM_EE_V770_depot.tar file to the /opt/ibm/sapm directory on the computer where the virtual machine image for IBM Tivoli Monitoring is deployed. SSH services are available on that computer to do the upload.
2. Run the following command to decompress the SCAPM_EE_V770_depot.tar file and copy the generated files to the agent depot directory:

   /opt/ibm/ae/AS/import_depot.sh /opt/ibm/sapm/SCAPM_EE_V7670_depot.tar

What to do next

Now you can deploy the agent to the computer that hosts the application that you want to monitor. See "Deploying a monitoring agent remotely" for information about how to deploy an agent remotely.

Deploying a monitoring agent remotely

To monitor an application, you must deploy a monitoring agent to collect monitoring data for it.

Before you begin

Deploy an OS monitoring agent to the computer that hosts the application that you want to monitor. See "Deploying an OS monitoring agent" on page 21 for information about how to deploy an OS monitoring agent.

Procedure

1. On the Launch Pad, click Deploy Application Monitoring. The Deploy Application Monitoring window is displayed.
2. Check the Deploy Application Monitoring Agent for System table to see if the computer on which you want to deploy application monitoring is listed. This table lists the computers on which an OS monitoring agent is deployed.
   - If the computer is listed in the table, go to the next step.
   - If the computer is not listed, you must deploy an OS monitoring agent to that computer before you continue with the process. See "Deploying an OS monitoring agent" on page 21 for information about how to deploy an OS monitoring agent.
3. Right-click the link icon that is next to the name of the target computer and then click Deploy Application on Windows or Deploy Application on Linux or UNIX, as appropriate. The default workspace for that computer is displayed, with an entry for the selected computer in the Physical Navigator view.
4. Right-click the entry in the Physical Navigator view and then click **Add Managed System** from the menu. The Select a Monitoring Agent window is displayed with a list of agents that can be deployed on the system.

5. Select the type of agent that you want to deploy and click **OK**.

6. Complete the configuration fields that are required for the agent. For detailed information about agent configuration parameters, see the Agent configuration information for remote deployment section in the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide.

7. Click **Finish**. You can check the status of the deployment in the Deployment Status Summary workspace. To open the Deployment Status Summary workspace, right-click **Enterprise** in the Physical Navigator view and then click **Workspaces > Deployment Status Summary**.

**Results**

After you deploy an application agent, entries for the agent and its predefined workspaces are displayed in the Physical Navigator view. The agent is also listed in the **Application Agents Currently Deployed** table.

**Recovering the deployment and reconfiguration**

If you enter incorrect parameter values or if a required parameter is not specified during the deployment of the two virtual machine images, the deployment fails. The components cannot be started when the deployment is not successful or when the network is not started. A script is provided for you to recover the configuration. If the virtual machine network is updated with new IP address or host name, you can also use this script to reconfigure the components that are running on the two virtual machines.

**Procedure**

1. Make sure that the network is correctly configured and started.
2. Log on the virtual machine on which the virtual machine image for IBM Tivoli Monitoring is deployed.
3. Run the following command:
   ```bash
   /opt/ibm/ae/AS/Config.sh -sysadminPWD <sysadmin_psw> -tdwIP <tdw_vm_ip>
   ```

   where **<sysadmin_psw>** is the password of the sysadmin, which is the default user of IBM Tivoli Monitoring; **<tdw_vm_ip>** is the IP address of the virtual machine that hosts the virtual machine image for Tivoli Data Warehouse.

**Related information**: Configure the network of the virtual machines

**Completing the installation or upgrade**

For information about how to install IBM SmartCloud Application Performance Management Entry Edition - VM Image, see the Installation and Deployment Guide. IBM SmartCloud Application Performance Management Entry Edition - VM Image Version 7.6 is the first release. Upgrading from a previous release is not required. However, patches are provided to upgrade IBM Tivoli Monitoring server components and IBM SmartCloud Application Performance Management agent depots. To deploy the maintenance patch, after you download the patch, use the Launch Pad to apply the patch.
About this task

**Remember:** Do not update IBM SmartCloud Application Performance Management Entry Edition - VM Image unless critical function failure occurs or security vulnerability exists.
Chapter 3. Viewing monitoring data

SmartCloud Application Performance Management Entry Edition - VM Image provides two ways for you to view the performance and availability data that is collected by the monitoring agents:

About this task

SmartCloud Application Performance Management Entry Edition - VM Image provides the following two ways for you to view the performance and availability data that is collected by the monitoring agents:

- “Viewing monitoring data in Tivoli Enterprise Portal”
- “Viewing monitoring data in IBM SmartCloud Application Performance Management UI” on page 32

Viewing monitoring data in Tivoli Enterprise Portal

You can view performance and availability data about your resources in Tivoli Enterprise Portal.

Before you begin


Procedure

1. Open a web browser and go to http://itm_vm_hostname:1920, where `itm_vm_hostname` is the fully qualified host name or IP address of the virtual machine to which the virtual machine image for IBM Tivoli Monitoring is deployed.

2. Click IBM Tivoli Enterprise Portal Web Client.

3. Use sysadmin as the user ID and its associated password to log on to Tivoli Enterprise Portal.

4. Close the Launch Pad.

5. Use the Navigator on the left side of the portal to navigate to specific monitored resources.

Results

The monitoring data for specific monitored resources is displayed in the views of the workspace.

Viewing monitoring data in IBM SmartCloud Application Performance Management UI

IBM SmartCloud Application Performance Management UI presents monitoring data from the perspective of an application.
SmartCloud Application Performance Management UI

SmartCloud Application Performance Management UI provides new, well-designed, customizable dashboards for monitoring applications in your IT environment.

SmartCloud Application Performance Management UI greatly improves the usability and time-to-value of application performance management by providing predefined dashboards. It adds value by providing the built-in group widgets for each domain application, based on industry best practices. It fulfills the customers’ requirements to monitor business applications by providing customized application dashboards with a few clicks.

Viewing monitoring data in IBM SmartCloud Application Performance Management UI

About this task

SmartCloud Application Performance Management UI presents the performance and availability data from the perspective of an application. Before you view data in SmartCloud Application Performance Management UI, ensure that you deployed monitoring for the application and that you created the application in SmartCloud Application Performance Management UI. See “Deploying monitoring for applications” on page 24 for information about how to deploy monitoring for an application. See “Creating an application” for information about how to create an application in SmartCloud Application Performance Management UI.

Procedure

1. To start the SmartCloud Application Performance Management UI, go to https://tdw_vm_host:9443, where tdw_vm_host is the fully qualified host name or IP address of the virtual machine to which the virtual machine image for Tivoli Data Warehouse is deployed.

2. Log in with the user name and password. The default user name is apmadmin. The default password is helloibm. The Getting Started page is displayed.

3. Click View application status > Start Now to start the SmartCloud Application Performance Management UI. The Application Performance Dashboard is displayed.
Chapter 4. Monitoring resources

Use the Launch Pad as the starting point to view real-time and historical availability and performance data for monitored resources. For data to be available, you must deploy monitoring agents.

More information about the workspaces, attributes, and situations that are provided by the included monitoring agents can be found in the user’s guides in the ITCAM for Applications Information Center (http://publib.boulder.ibm.com/infocenter/tivihelp/v24r1/topic/com.ibm.itcama.doc_7.2.1/welcome_apps721.html).

Monitoring operating systems

You can view availability and performance data for monitored operating systems.

About this task

Availability and performance data for monitored operating systems is provided in workspaces. The level of detail depends on whether monitoring is agent-based or agentless.

Procedure

1. On the Launch Pad, click View System Availability and Performance. The System Availability and Performance workspace is displayed. This workspace lists the monitored operating systems in your network by platform and the status of each system (online or offline).
2. Click the link icon that is next to an online system to access detailed performance data. The default workspace for the selected operating system is displayed.
3. Click the plus icon (+) to view the available workspaces.
4. Click the name of the workspace that you want to view.

Results

In the workspaces, views that are enabled for historical reporting have a Time Span icon in the view toolbar. Historical data collection must be enabled and started for historical data to be available. By default, historical data collection is enabled.

For more information about the information available in each workspace, select the help for the appropriate operating system agent.

Monitoring applications

You can view availability and performance data for monitored applications.

Before you begin

You must first deploy monitoring for applications before you can view monitoring data for them. See “Deploying monitoring for applications” on page 24 for information about how to deploy monitoring for applications.
About this task

Availability and performance data for monitored applications is provided in workspaces.

Procedure

1. On the Launch Pad, click View Application Availability and Performance. The Application Availability and Performance workspace is displayed. This workspace shows the monitored applications by operating system.
2. Click the link icon that is next to an application to access detailed performance data. The default workspace for the selected application is displayed.
3. Click the plus icon (+) to view the available workspaces.
4. Click the name of the workspace that you want to view.

Results

In the workspaces, views that are enabled for historical reporting have a Time Span icon in the view toolbar. Historical data collection must be enabled and started for historical data to be available. By default, historical data collection is enabled.

For more information about each workspace, select the help for the appropriate application monitoring agent from the Navigator.

Monitoring events

The views in the Enterprise Status workspace give an overview and status of situation events in your monitored environment.

About this task

The Enterprise Status workspace is the initial default workspace in the physical navigator view. The views in this workspace give an overview and status of situation events in your monitored environment. The Situation Event Console view lists the open events and their severities.

To access the Enterprise Status workspace from the Launch Pad, click Manage Events.

If an event indicator is displayed on a Navigator item, you can move the mouse pointer over the item to open a list of open situation events with summary information. When you move up the Navigator hierarchy, multiple events are consolidated to show only the indicator of the highest severity. Each situation in the list has a link to the event results workspace for that situation.

The event results workspace shows the values of the attributes at the time the situation was evaluated as true and their current values. It shows any expert advice that the situation author might have written and any hypertext links to go to for more information. Use the Take Action view to select or define a command to be run at the managed system.

Responding to events

When an event occurs, you have multiple ways to respond to the event.
About this task

Right-click an event, a menu will be displayed. The menu includes several options for working with the situation and event:

- Edit the situation
- Start the situation
- Stop the situation
- Quick acknowledge the event
- Acknowledge the event
- Close the event

If multiple users are monitoring the network for events, one of them can acknowledge an event to indicate that it was seen and that the problem is being worked on. Acknowledging an event changes the event status from Open to Acknowledged until the acknowledgement expires or until the situation is no longer true. You can add notes to an acknowledgement and attach files that are pertinent to the event.

The My Acknowledged Events table in the Enterprise Status workspace shows the events that are assigned to the current user. This view shows both open and closed events. Closed events are displayed so that you can access the notes and actions that are taken against these events. For each event record listed, to open the Event Details workspace with similar events based on the situation name, click the link indicator at the beginning of the event row.

To see the other Event Details workspaces, right-click the link indicator. The Event Details workspace shows any notes and attachments for the acknowledged event, along with other related events and a link to the IBM Tivoli Open Process Automation Library where you can find analytical tools for situations.

Only pure events can be closed. Pure events reflect conditions that do not alter over time without intervention, such as a printer that is out of paper. Such events are not closed automatically if the conditions change.

For more information about monitoring and responding to events, see the section on [Responding to events] in the IBM Tivoli Monitoring: Tivoli Enterprise Portal User’s Guide.
Chapter 5. Monitoring virtual environments

Follow the instructions to monitor your virtual environments.

About this task

Tivoli Monitoring for Virtual Environments, which is included in the virtual machine image for IBM Tivoli Monitoring, provides a comprehensive tool to monitor the performance and availability of virtual environments. In addition, Tivoli Monitoring for Virtual Environments provides performance and capacity reporting of virtual environments. The tool also provides you with capacity planning activities to optimize, consolidate, and balance the overall capacity of the virtual environments.

To use Tivoli Monitoring for Virtual Environments to monitor your virtual environments, do the following steps:

Procedure

1. Deploy monitoring for your virtual environments. See “Deploying monitoring for applications” on page 24 for information about how to deploy monitoring for virtual environments.

2. Configure the connection to the Virtual Environments Dashboard. See Configuring the Capacity Planners and the Dashboard for VMware. When you are prompted to enter configuration parameters, note that for **TEPS Hostname**, enter the host name or IP address of the computer on which the virtual machine image for IBM Tivoli Monitoring is deployed. **TEPS Password** is the password for the sysadmin user ID. You can ignore all the parameters that start with the string TADDM.

3. If you want to use the Virtual Environments Dashboard, you must configure Capacity Planner federation. See Configuring the Capacity Planners and the Dashboard for VMware for information about how to configure Capacity Planner federation.

Results

Now you can view the monitoring data for your virtual environments. For more information about Tivoli Monitoring for Virtual Environments, see IBM Tivoli Monitoring for Virtual Environments Information Center.
Chapter 6. Managing historical data collection

Historical data collection is an optional feature that you can enable through the Tivoli Enterprise Portal. The collected data can be displayed in workspaces in the Tivoli Enterprise Portal, warehoused analyses, and long-term data reports. It can also be exported to third-party tools for reporting and analysis.

Historical data collection must be configured and started for historical data to be available. You configure and start historical data collection by using the History Collection Configuration window. In this window, you specify the product and attribute groups for which you want data to be collected, the interval for data collection, the location where you want the collected data to be stored (at the monitoring server or at the agent), and whether you want the data to be stored in the Tivoli Data Warehouse. By default, historical data collection is configured and started for the attribute groups that are required for the Tivoli Common Reporting best practices reports. Summarization and pruning are configured for those groups.

Remember:

• Historical data collection requires more disk space. You must ensure that there is enough space on the system when configuring historical data collection. For information about estimating the required disk space, see the Disk capacity planning for historical data section of the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide.

• Historical data is required by Tivoli Performance Analyzer, which is provided in the virtual machine image for Tivoli Data Warehouse by SmartCloud Application Performance Management Entry Edition - VM Image. Tivoli Performance Analyzer adds predictive capability to Tivoli Monitoring. You can monitor resource consumption trends, anticipate future performance issues, and avoid or resolve problems more quickly. For example, you can use Tivoli Performance Analyzer, which is fully automated, to predict application bottlenecks and to create alerts for potential service threats. To use Tivoli Performance Analyzer, you must enable historical data collection first. For detailed information about how to use Tivoli Performance Analyzer, see the IBM Tivoli Performance Analyzer Information Center.

Configuring historical data collection

For historical data to be available for reporting in the workspace views, historical data collection for the appropriate products and attribute groups must be configured and started. Historical data collection is configured and started using the History Collection Configuration window.

To configure historical data collection, do the following steps:

1. Open a web browser and go to http://itm_vm_hostname:1920, where itm_vm_hostname is the fully qualified host name or IP address of the virtual machine to which the virtual machine image for IBM Tivoli Monitoring is deployed.

2. Click IBM Tivoli Enterprise Portal Web Client.

3. Use sysadmin as the user ID and its associated password to log on to Tivoli Enterprise Portal.

4. Close the Launch Pad.
5. Click **Edit > History Configuration.** The History Collection Configuration window is displayed.

You can use the Historical Collection Configuration window to complete the following tasks:

- Turn on or off historical collection for individual attribute groups
- Save the history data at the Tivoli Enterprise Monitoring Server or at the agent
- Turn on and off data warehousing and specify the interval that is used to save data into the warehouse
- Define how you want to summarize the warehoused data
- Define how and when you want to prune the warehoused data and how long you want it to be kept

For more information about how to use the Historical Collection Configuration window to achieve these tasks, see [Historical data collection configuration](http://publib.boulder.ibm.com/infocenter/tivihelp/v24r1/topic/com.ibm.itm.doc_6.3fp2/adminuse/history_manage_intro.htm).

The configurations that are required for reporting are turned on by default.

Some attributes groups, such as Situation Status and Windows Event Log, are historical in nature and show all their entries without your specifying a time span. You do not have to configure historical collection for these attribute groups unless you want to roll off the data to a data warehouse or limit the reported data.


---

### Managing collected data

After data collection is started, historical data is collected in binary files at either the monitoring agent or the monitoring server for the short term. The data is stored in tables, with one table for each attribute group for which data is being collected. You can roll off the data to the Tivoli Data Warehouse for longer term storage.

If you upload data to the data warehouse, the data at the collection locations is automatically deleted after the upload. If you choose not to warehouse your data, you must institute roll-off jobs to regularly convert and empty out the history data files. Tivoli Management Services provides roll-off programs for all platforms. These programs are described in the *IBM Tivoli Monitoring Administrator’s Guide*. In addition to trimming the binary history data files, these scripts produce flat files. These flat files can be used with third-party vendor tools to produce trend analysis reports and graphics. The *IBM Tivoli Monitoring Administrator’s Guide* also provides more information about managing the collected data, performance considerations, and data management options.

Data that is stored in the Tivoli Data Warehouse is managed by summarizing and pruning, which is configured through the **History Collection Configuration** window.
Monitoring the warehouse agents

About this task

Two agents are associated with the Tivoli Data Warehouse. The Warehouse Proxy Agent collects data from monitoring agents and passes the data to the warehouse. The Summarization and Pruning Agent periodically aggregates and prunes the data in the warehouse. These agents are configured and started by default so that historical data can be collected for the Tivoli Common Reporting reports.

The warehouse agents are self-monitoring. To view configuration and status information for these agents, complete the following steps:

Procedure

1. On the Launch Pad, click Monitor Warehouse Agent Configuration. The Data Warehouse workspace is displayed.
2. Click the link icon that is next to the name of the agent in the Data Warehouse Items table. The default workspace for the selected agent is displayed.
3. Expand the navigation tree for the Summarization and Pruning Agent to see its Configuration and Statistics workspaces.

What to do next

For descriptions of the Warehouse Proxy and Summarization and Pruning agents workspaces, see the Tivoli Enterprise Portal online help.

Viewing historical data

In the Tivoli Enterprise Portal workspaces, views for which historical reporting is enabled display the Time Span tool icon in the view toolbar.

To see historical data in a history-enabled view, you must specify the time span for which you want to see data. To return to viewing current data, you must discontinue the reporting of historical data. Historical data collection must be enabled and started for historical data to be available. For more information about time span and discontinuing historical reporting, see the sections on Setting a time span to display and Discontinuing historical reporting in the IBM Tivoli Monitoring: Tivoli Enterprise Portal User’s Guide.

Data for up to 24 hours is taken from the local data store. Data for more than 24 hours is taken from the data warehouse.
Chapter 7. Using Tivoli Common Reporting

Tivoli Common Reporting is a reporting tool that you can use across Tivoli products. Tivoli Common Reporting provides a consistent approach to viewing and administering historical reports.

Before you can view the reports in Tivoli Common Reporting, ensure that you deployed monitoring agents to the applications. Also ensure that historical data exists in the data warehouse.

The configurations that are required for the best practice reports are enabled by default.

When you log in to Tivoli Common Reporting, your reports are organized under the following groups:

- IBM Tivoli Capacity Analytics Reports
- IBM Tivoli Composite Application Manager Agent for DB2
- IBM Tivoli Monitoring for Virtual Environments Reports
- IBM Tivoli Monitoring OS Agents Reports
- ITCAM for Transactions (Analysis)
- ITCAM for Transactions (Query)
- ITCAMMA Active Directory Cognos Reports
- ITCAMMA BizTalk Server Cognos Reports
- ITCAMMA Cluster Server Cognos Reports
- ITCAMMA DotNet Cognos Reports
- ITCAMMA Exchange Server Cognos Reports
- ITCAMMA HIS Cognos Reports
- ITCAMMA Hyper-V Server Cognos Reports
- ITCAMMA IIS Cognos Reports
- ITCAMMA LyncServer Cognos Reports
- ITCAMMA SharePoint Cognos Reports
- ITCAMMA SQL Server Cognos Reports

Reports are run against long-term historical data that is stored in the Tivoli Data Warehouse. Using the provided templates, you can generate reports in any of the following formats: HTML (the default), PDF, Microsoft Excel, or Adobe PostScript. You can manually run reports on demand or schedule them to run automatically. Reports can help you monitor the performance and availability of your managed resources over time.

For descriptions of data model and reports that are provided by the monitoring agent, see the Tivoli Common Reporting information for the monitoring agent section in the SmartCloud Application Performance Management Entry Edition - VM Image version 7.7 reference guide.

Tivoli Common Reporting uses the Tivoli Integrated Portal. The SmartCloud Application Performance Management Entry Edition - VM Image provides a predefined Tivoli Integrated Portal administrative user ID and password. To change the administrative password, or to add more Tivoli Integrated Portal users,
Creating and populating the resource dimension table

If you want to generate reports for IBM Tivoli Monitoring OS Agents, you must create and populate the resource dimension table.

About this task

If you want to generate reports for IBM Tivoli Monitoring OS Agents, you must create and populate the resource dimension table. Each time that you deploy one or more OS monitoring agents, you must do this task to update the resource dimension table.

Important: The following scripts use hardcoded user schemas. If you use a different schema, you must replace every instance of the hardcoded schema with the user that you specified.

Procedure

1. On the computer where the virtual machine image for Tivoli Data Warehouse is deployed, log in as db2inst1. The db2inst1 user ID is a predefined user ID. If you did not modify the user ID password, the default password is helloibm.
2. Connect to the database that you want to create the resource dimension table for. This database is your Tivoli Data Warehouse.
   ```
   db2 connect to WAREHOUSE
   ```
3. If you specified a different user from the default of ITMUSER for connecting to the warehouse, customize the provided gen_resources.db2 and populate_resources.db2 scripts, replacing every instance of the hardcoded schema of ITMUSER with the user that you specified.
4. Call the following procedure to populate the ManagedSystem table:
   ```
   db2 "call ITMUSER.POPULATE_OSAGENTS()"
   ```
   Important: If you specified a different user from the default, replace ITMUSER with the user that was specified during your warehouse configuration.

Results

The resource dimension table is complete.

Generating reports

You can manually generate Tivoli Common Reporting reports to view them on demand.

Procedure

1. From the Launch Pad, select View Historical Reports. The Tivoli Common Reporting workspace is displayed. The workspace contains the logon panel for the Tivoli Integrated Portal, which is used as the interface to select, run, and schedule Tivoli Common Reporting reports.
2. If you are logging on to Tivoli Integrated Portal for the first time, use the default user ID (tipadmin) and password. On subsequent logons, you can use any valid Tivoli Integrated Portal user ID and password that were created.
3. Select the Navigation tab.
4. Locate the report that you want to run using the Navigation or Search tab.
5. In the Reports table, right-click the table row for the report that you want to run, and select one of the following report formats: HTML (the default), PDF, Microsoft Excel, or Adobe PostScript.
6. Click the icon that is next to a report name to produce a report in the selected format. The OnDemand Report Parameters window is displayed. The title of this window indicates the type of report that is generated.
7. Click Run to generate a report that matches your parameter definitions. An hourglass is displayed while Tivoli Common Reporting gathers report data and creates formatted output.

Results

After processing finishes, the report viewer opens in a new browser tab or instance, displaying the formatted report. You can view the report in your browser or save the formatted output.

If you are viewing an HTML or PDF report, you can also click any embedded links to open drill-through reports. Clicking a drill-through embedded link causes the report to link back to itself with the newly passed parameters or to a secondary (detailed or summarized) report. Examples of links that you can drill down through include clicking a bar chart, a line chart, or on a table heading.


Scheduling reports

You can create a report schedule in the Create Report Schedule window.

Procedure

1. Locate the report that you want to run in the Navigation or Search tab.
2. In the Reports table, right-click the table row for the report and select Schedules from the menu. The Report Schedules window opens.
4. On the Report Parameters tab, specify the parameter values that you want to use or accept the default values. The parameters for a report are defined by the report design. For more information about the parameters of the report you are running, see the documentation that is provided with the report.
5. On the Schedule tab, specify the scheduling rule that defines when the snapshot runs. The scheduling rule specifies the start and end times for the schedule, the type of repeat schedule to use, and other options that affect when the report snapshot runs. For more information about these options, see the online help for the Create Report Schedule window.
6. When you finish specifying report parameters and the scheduling rule, click OK to create the schedule.

Results

The new schedule is displayed in the Report Schedules window.
What to do next

To see a menu of options for managing reports, right-click any listed report schedule. You can use this menu to cancel, suspend, resume, or delete a schedule.
Chapter 8. Upgrading and upgrading components

When a new version of a component in SmartCloud Application Performance Management Entry Edition - VM Image is released, you can upgrade the component to the new version.

Single patch upgrading from a previous release of SmartCloud Application Performance Management Entry Edition - VM Image is not supported. However, patches are provided to upgrade IBM Tivoli Monitoring servers and monitoring agents. Direct upgrade from SmartCloud Application Performance Management Entry Edition - VM Image version 7.6 is not supported in IBM SmartCloud Application Performance Management UI version 7.7.

**Important:** Do not upgrade SmartCloud Application Performance Management Entry Edition - VM Image unless critical function failure occurs or security vulnerability exists.

---

**Roadmap for upgrading a monitoring agent**

When a new version of a component in SmartCloud Application Performance Management Entry Edition - VM Image is released, you can upgrade the component to the new version.

**About this task**

If the component that you want to upgrade is a monitoring agent, follow the instructions to upgrade the agent.

**Procedure**

1. Download the upgrade image from the IBM Support website.
2. Upload the upgrade image. See “Uploading the upgrade image” on page 48 for information about how to upload the upgrade image.
3. Update the agent installation files. See “Updating agent installation files” on page 49.
4. Do one of the following steps to upgrade the agent:
   - “Updating an agent through Tivoli Enterprise Portal” on page 49
   - “Updating an agent through the command-line interface” on page 50

---

**Roadmap for upgrading an IBM Tivoli Monitoring server**

**About this task**

If the component that you want to upgrade is a Tivoli Enterprise Monitoring Server, or a Tivoli Enterprise Portal Server, follow the instructions to upgrade the component:

**Procedure**

1. Download the upgrade image from the IBM Support website.
2. Upload the upgrade image to a temporary directory on the virtual machine where the server that you want to upgrade is deployed. To upload the image, SSH service is available on the virtual machine.

3. **Upgrade the server.** See “Upgrading IBM Tivoli Monitoring server components” on page 51.

4. Run the following command to check the version of IBM Tivoli Monitoring to verify the upgrade.
   ```
cinfo -t
```

---

**Roadmap for upgrading other components**

### About this task

If the component that you want to upgrade is not a monitoring agent, a monitoring server, or a portal server, follow these instructions to upgrade the component.

### Procedure

1. Download the upgrade image from the IBM Support website.
2. Upload the upgrade image to the virtual machine on which the component you want to upgrade is deployed.
3. Follow the instructions in the documentation of that component to upgrade it.

---

**Uploading the upgrade image**

### About this task

The upload process that you use to upload the upgrade image depends on the size of the upgrade image.

- If the upgrade image size is smaller than 2 GB, you can use the following process to upload it to the virtual machine on which the virtual machine image for IBM Tivoli Monitoring is deployed.
- If the image size is greater than 2 GB, use a file transfer tool other than the following process to upload the image to the `/opt/ibm/sapm/fixpack_images` directory on that virtual machine.

### Procedure

1. Do the following steps to open the Launch Pad:
   a. Open a web browser and go to `http://itm_vm_hostname:1920`, where `itm_vm_hostname` is the fully qualified host name or IP address of the virtual machine to which the virtual machine image for IBM Tivoli Monitoring is deployed.
   b. Click **IBM Tivoli Enterprise Portal Web Client**.
   c. Log on to Tivoli Enterprise Portal. The Launch Pad is displayed.
2. Click **Maintain Appliance**.
3. Select **Upgrade Components** and then click **Next**.
4. Select the component that you want to upgrade, click **Browse** to locate the upgrade image that you want to upload, and then click **Next**. The image is uploaded to the `/opt/ibm/sapm/fixpack_images` directory. If the upgrade image
is for the IBM SmartCloud Application Performance Management UI, it is transferred to the virtual machine on which the virtual machine image for Tivoli Data Warehouse is deployed.

### Updating agent installation files

You can use the following process to update agent installation files.

**Procedure**
1. In the **Target VM** field, select the virtual machine on which the component you want to upgrade is deployed.
2. Extract the archive file with the `tar` or `unzip` command. Refer to the following example:
   ```
   tar -xf /opt/ibm/sapm/fixpack_images/6.2.2.1-TIV-ITM_DB2-LA0051.tar -C /opt/ibm
   /sapm/fixpack_images/6.2.2.1-TIV-ITM_DB2-LA0051
   ```
3. Add the agent fix bundles into the remote deployment depot with the `tacmd addBundles` command. Use the `-i` option to specify the directory that contains the deployment bundles to be added to the depot as shown in the following example. For more information about the `tacmd addBundles` command, see the IBM Tivoli Monitoring Administrator’s Guide.
   ```
   /opt/IBM/ITM/bin/tacmd addBundles -f -i /opt/ibm/sapm/fixpack_images
   /<your_extracted_image_directory>
   ```

**What to do next**

- “Updating an agent through Tivoli Enterprise Portal” or “Updating an agent through the command-line interface” on page 50

### Updating an agent through Tivoli Enterprise Portal

When a new version of a distributed monitoring agent is released, you can apply the new version locally or remotely. You can apply the new version to one managed system at a time, or to many systems simultaneously.

**Before you begin**

Use the Configure Managed System window in the Tivoli Enterprise Portal client to apply a patch for a monitoring agent.

**Procedure**
1. Do the following steps to log on to the Tivoli Enterprise Portal:
   a. Open a web browser and go to `http://itm_vm_hostname:1920`, where `itm_vm_hostname` is the fully qualified host name or IP address of the virtual machine to which the virtual machine image for IBM Tivoli Monitoring is deployed.
   b. Click **IBM Tivoli Enterprise Portal Web Client**.
   c. Log on to Tivoli Enterprise Portal.
2. Right-click the Navigator item for the agent that you want to upgrade.
3. Click **Configure** to open the Configure Managed System window.
4. Click the **Agent** tab.
5. Compare the installed version of the monitoring agent with any available product updates, then select the row of the agent to update and click **Install**
Updates. The list that displays reflects the contents of the deployment depot. If Install Updates is disabled, one or more of the following conditions exist:

- The depot entry does not match the product type.
- The VVRR fields for the agent and the depot entry are the same, where VV is the version number and RR is the revision number. For example, an entry of 0610 prevents you from applying a fix pack that is intended for a version 6.2 agent.
- The depot entry is at an older version than the agent.
- The host version field of the depot entry does not contain the host platform for the agent.
- The prereq field of the depot entry does not contain an agent of the same type as the agent itself. For example, if 6.1 UD (DB2 monitoring) is the selected agent, the prereq field in the depot entry must contain a deployment bundle notation such as ud:06100000. This example is one way to denote a patch deployment bundle.

Results

Installation of the updates begins and might take several minutes to complete.

Updating an agent through the command-line interface

Updating agents involves stopping any agents that are running, applying the changes, and restarting them. After you determine the information about monitoring agents that you want to update, including the type and version, run the tacmd updateAgent command from the command-line interface. If a version is not specified, the agent is updated to the latest version.

About this task

Complete the following steps at a command-line interface. For reference information about this command and related commands, see the IBM Tivoli Monitoring Command Reference [https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=0587adbc-8477-431f-8c68-9226ade11ed#fullpageWidgetId=W42ce7c6afdb9_42c2_a9ea_e1ba310bea8c&file=83016a5e-5936-4959-9199-d06a6f0eec02].

Procedure

1. Use the tacmd login command to log in to a Tivoli Enterprise Monitoring Server.

   `tacmd login {-s|--server} {[https|http]://HOST[:PORT]} [-u|--username] USERNAME [-p|--password] PASSWORD [-t|--timeout] TIMEOUT [-t TIMEOUT]

   For example, to log in to the system ms.austin.ibm.com with the user name Admin and the password log1n, run this command:

   `tacmd login -s ms.austin.ibm.com -u Admin -p log1n`

2. After you log in, issue the tacmd updateAgent command to install an agent update to a specified node.

   `tacmd updateAgent {-t|--type} TYPE {-n|--node} MANAGED-OS [{-v|--version} VERSION] [{-f|--force}]`
For example, the following command updates a UNIX agent (type UX) on the server named itmserver:

tacmd updateagent -t UX -n itmserver:KUX -v 6111

### Upgrading IBM Tivoli Monitoring server components

#### About this task

Use one of the following instructions to upgrade IBM Tivoli Monitoring server components:

- If you want to upgrade the server components to a fix pack level, see “Upgrading IBM Tivoli Monitoring server components to a fix pack.”
- If you want to upgrade the server components to a patch level, see “Upgrading IBM Tivoli Monitoring server components to a patch” on page 52.

#### Upgrading IBM Tivoli Monitoring server components to a fix pack

#### Procedure

1. Download the upgrade image from the IBM Support website.
2. Read the related installation guide for the fix pack and create a silent response file.
3. Upload the installation image and the response file to the /opt/ibm/sapm/fixpack_images directory on the virtual machine of IBM Tivoli Monitoring or to Tivoli Data Warehouse, depending on where the component that you want to upgrade is deployed.
4. Run one of the following commands to install the patch, depending on the type of the patch:
   - If the patch is a fix pack, run the following command:

     ```
     /opt/ibm/ae/AS/InstallITMFP.sh -image fix_pack_path -response_file response_file_path
     ```

     where `fix_pack_path` is the full path of the fix pack file and `response_file_path` is the full path of the response file. If no response file is specified, the default response file in the fix pack image is used. For example,

     ```
     ```
   - If the patch is an interim fix, provisional fix, or other patches, run the following command:

     ```
     /opt/ibm/ae/AS/InstallITMPatch.sh -image patch_path -patch.arg patch_argument
     ```

     where `patch_path` is the full path of the patch file and `patch_argument` is the argument that is required by the patch. For example:

     ```
     /opt/ibm/ae/AS/InstallITMPatch.sh -image /opt/ibm/sapm/fixpack_images/6.2.3-TIV-ITM-FP0002-IV29900.tar -patch.arg /opt/ibm/sapm/fixpack_images/6.2.3-TIV-ITM-FP0002-IV29900
     ```

**Remember:** The installation scripts extract the compressed installation image file to the /opt/ibm/sapm/fixpack_images directory and stop the related components before the upgrade. The components that are stopped are started automatically after the upgrade is complete.
Upgrading IBM Tivoli Monitoring server components to a patch

Procedure
1. Download the patch image from the IBM Support website.
2. Read the related installation guide or readme file for the patch.
3. Upload the installation image to the /opt/ibm/sapm/fixpack_images directory on the virtual machine of IBM Tivoli Monitoring or Tivoli Data Warehouse, depending on where the component you want to upgrade is deployed.
4. Decompress the patch image to a temporary directory.
5. Stop the IBM Tivoli Monitoring components that are running on the virtual machine with the following command:
   /etc/init.d/ITMAgents1 stop
6. Install the patch using the itmpatch command. For example,
   TEMP_dir/patch_dir/itmpatch -h ITM_HOME -i
   TEMP_dir/patch_dir

   where TEMP_dir is the temporary directory where you save the patch image, patch_dir is the directory that is created when the patch image is decompressed, and ITM_HOME is the directory where IBM Tivoli Monitoring is installed.
7. Start the components that you stopped in step 5 with the following command:
   /etc/init.d/ITMAgents1 start
Chapter 9. Troubleshooting

When you encounter a problem with SmartCloud Application Performance Management Entry Edition - VM Image, you must first determine where the problem originated. Usually you start with a symptom, or set of symptoms, and trace them back to their cause. This process is called troubleshooting. Troubleshooting is not the same as problem solving, although during the process of troubleshooting, you can obtain enough information to solve a problem. The following situations are some examples of situations where this event can happen:

- User errors
- Application programming errors
- System programming errors, such as in resource definitions

You might not always be able to solve a problem yourself after determining its cause. For example, a performance problem might be caused by a limitation of hardware. If you cannot solve a problem on your own, contact IBM Software Support for a solution.

IBM Tivoli Monitoring

The IBM Tivoli Monitoring Troubleshooting Guide provides you with troubleshooting information for various components in IBM Tivoli Monitoring. The IBM Tivoli Monitoring Troubleshooting Guide is available in the Files section of the Application Performance Management community on Service Management Connect. The following areas are covered:

- Tivoli Enterprise Portal
- Tivoli Enterprise Portal Server
- Tivoli Enterprise Monitoring Server

Monitoring agents

Each monitoring agent provides agent-specific troubleshooting information in the respective user’s guide:

- For troubleshooting information about the DB2 agent, see the IBM Tivoli Composite Application Manager Agent for DB2 User’s Guide [https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=0587adbc-8477-431f-8c68-9226adea11ed#fullpageWidgetId=W42ce7c6afdb9_42c2_a9ea_e1ba310bea8c&file=03991861-ea4b0-a462-a1becc620d87].

- For troubleshooting information about the HTTP Servers agent, see the IBM Tivoli Composite Application Manager Agent for HTTP Servers [https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli%20Composite%20Application%20Manager/page/Troubleshooting%20guide%20for%20Agent%20for%20WebSphere%20Applications%207.2%20C%20Agent%20for%20J2EE%207.1%20C%20Agent%20for%20HTTP%20Servers%207.1].

- For troubleshooting information about the Lotus Domino agent, see the IBM Tivoli Composite Application Manager Agent for Lotus Domino User’s Guide [https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=0587adbc-8477-431f-8c68-9226adea11ed#fullpageWidgetId=W42ce7c6afdb9_42c2_a9ea_e1ba310bea8c&file=4962f595-b0dc-4348-a2fe-e28a0ae01cb3].
For troubleshooting information about the Oracle Database agent, see the IBM Tivoli Composite Application Manager Extended Agent for Oracle Database User’s Guide [https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=0587adbc-8477-431f-8c68-9226adea11ed#fullpageWidgetId=W42ce7c6afdb9_42c2_a9ea_e1ba310bea8c&file=9b943724-22fe-4bd7-a7fd-678af1a04f78](https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=0587adbc-8477-431f-8c68-9226adea11ed#fullpageWidgetId=W42ce7c6afdb9_42c2_a9ea_e1ba310bea8c&file=9b943724-22fe-4bd7-a7fd-678af1a04f78).


Collecting logs

The Launch Pad provides a pdcollect tool to collect the most commonly used information from a system. The pdcollect tool is used to gather log files, configuration information, version information, and other information to help solve a problem. Technicians in IBM Software Support use this information to investigate a problem.

About this task

You can also use the tool to manage the size of trace data repositories. The pdcollect tool is run from the tacmd pdcollect command. To use this tool, complete the following steps:

Procedure

1. On the Launch Pad, click Maintain Appliance.
2. Click Download in the Download ITM Log field. The collecting process begins and might take a few minutes. After the collecting process is complete, a compressed log file is created.
3. Choose the local folder to which you want to save the log file.

Agent remote deployment fails

Various reasons can cause the failure of agent remote deployment. Use one of the following solutions that best suits your situation to solve the problem.

Windows OS agent

**Problem:** The Windows OS agent fails to start after remote deployment. The KCICF5100E error message is displayed. In the trace log file of the agent, the following message might be recorded:

No perfmon counters found, exiting agent

**Solution:** Complete the following steps to repair the pointers in the registry:

1. On the Windows system, click Start.
2. In the Search programs and files field, type cmd.
3. In the search results, right-click cmd.exe and click Run as administrator.
4. In the command prompt, type 1odctr /R and press Enter.
Linux OS agent

The following reasons might cause the failure of Linux OS agent installation.

**Missing 32-bit library on a 64-bit system**

**Problem:** The OS agent cannot be installed on a 64-bit Linux system with errors that are similar to the following ones:

```
```

**Solution:** IBM Tivoli Monitoring requires both the 32-bit and 64-bit compat-libstdc++ libraries that are installed on a 64-bit system. This problem occurs because of the missing 32-bit libstdc++.so.5 library. Use the following command to verify that both the 32-bit and 64-bit versions of the libraries are installed. The expected results are also shown following the command. If any entries in the /usr/lib64 directory are missing from the /usr/lib directory, you must locate and install the 32-bit version of the compat-libstdc++-33 package.

```
# rpm -q --filesbypkg compat-libstdc++-33 compat-libstdc++-33 /usr/lib64/libstdc++.so.5 compat-libstdc++-33 /usr/lib64/libstdc++.so.5.0.7 compat-libstdc++-33 /usr/lib/libstdc++.so.5 compat-libstdc++-33 /usr/lib/libstdc++.so.5.0.7
# rpm -q --qf "%{NAME}-%{VERSION}-%{RELEASE}.%{ARCH}\n" compat-libstdc++-33 compat-libstdc++-33-3.2.3-61.x86_64 compat-libstdc++-33-3.2.3-61.i386
```

**Inappropriate SELinux settings**

**Problem:** The OS agent deployment fails because SELinux is set to permissive or enforcing. SELinux is a set of extra security restrictions on top of the normal Linux security tools. The permissive or enforcing SELinux setting is too restrictive for agent installation.

**Solution:** To solve this problem, disable SELinux, run the prelink -a command, and deploy the OS agent again. To disable SELinux, complete the following steps:

1. Open the /etc/selinux/config file.
2. Set the SELINUX parameter to disabled.
3. Restart the system.

**Missing Secure Shell**

**Problem:** The OS agent deployment fails because Secure Shell is not installed on the system.
**Solution:** Install Secure Shell on the target Linux system and deploy the OS agent again.

**Missing Korn shell**

**Problem:** The OS agent deployment fails because Korn shell (ksh) is not installed on the system.

**Solution:** IBM Tivoli Monitoring requires ksh to run the installation program. To solve this problem, install ksh on the target system and deploy the OS agent again.

**UNIX OS agent**

The following reasons might cause the failure of UNIX OS agent installation.

**Missing Secure Shell**

**Problem:** The OS agent deployment fails because Secure Shell is not installed on the system.

**Solution:** Install Secure Shell on the target UNIX system and deploy the OS agent again.

**Missing Korn shell**

**Problem:** The OS agent deployment fails because Korn shell (ksh) is not installed on the system.

**Solution:** IBM Tivoli Monitoring requires ksh to run the installation program. To solve this problem, install ksh on the target system and deploy the OS agent again.

**Unknown host name issue**

**Problem:** Remote agent deployment fails because of the unknown host name of the monitoring server.

**Solution:** Agent cannot connect to the monitoring server by using the host name. Use IP address of the computer on which the monitoring server is running.

---

**Fails to log on to Tivoli Enterprise Portal**

**Problem:** Click IBM Tivoli Enterprise Portal Web Client to log on, however, the browser hangs and gives no response.

**Solution:** To resolve this problem, take one of the following actions:

- Click **IBM Tivoli Enterprise Portal Webstart Client** to log on.
- Remove the files in the C:\Documents and Settings\Administrator\Application Data\IBM\Java\Development\cache directory and then log on.

---

**Cannot access Tivoli Enterprise Portal Web client**

When you want to access the Tivoli Enterprise Portal Web client, the operation fails with the KFWITM474E error message displayed. To solve the problem, allocate enough memory for the Java™ applet, which is required for the client to connect to the portal server.
**Problem:** When you use the Web client to visit Tivoli Enterprise Portal, the operation fails and the KFWITM474E error message is displayed.

**Solution:** When the browser client connects to the Tivoli Enterprise Portal Server, it downloads a Java applet. Allocate enough memory for the applet to avoid out-of-memory problems. The instructions are available in the *IBM Tivoli Monitoring Administrator’s Guide* (See [http://pic.dhe.ibm.com/infocenter/tivihelp/v63r1/topic/com.ibm.itm.doc_6.2.3fp1/adminuse/clientbrowser_javamemory_itm.htm](http://pic.dhe.ibm.com/infocenter/tivihelp/v63r1/topic/com.ibm.itm.doc_6.2.3fp1/adminuse/clientbrowser_javamemory_itm.htm)).

---

**Section names in English**

**Problem:** During the deployment procedure, the section names on the window for configuring parameters are displayed in English for a non-English version.

**Solution:** No solution.
Appendix. Accessibility

Accessibility features help users with physical disabilities, such as restricted mobility or limited vision, to use software products successfully.

The major accessibility features in this product enable users in the following ways:

- Use assistive technologies, such as screen-reader software and digital speech synthesizer, to hear what is displayed on the screen. Consult the product documentation of the assistive technology for details on using those technologies with this product.
- Operate specific or equivalent features using only the keyboard.
- Magnify what is displayed on the screen.

In addition, the product documentation was modified to include the following features to aid accessibility:

- All documentation is available in both HTML and convertible PDF formats to give the maximum opportunity for users to apply screen-reader software.
- All images in the documentation are provided with alternative text so that users with vision impairments can understand the contents of the images.

Navigating the interface with the keyboard

Standard shortcut and accelerator keys are used by the product and are documented by the operating system. For more information, see the documentation that is provided by your operating system.

Magnifying what is displayed on the screen

You can enlarge information in the product windows using facilities that are provided by the operating systems on which the product is run. For example, in a Microsoft Windows environment, you can lower the resolution of the screen to enlarge the font sizes of the text on the screen. For more information, see the documentation that is provided by your operating system.
Glossary

This glossary includes terms and definitions for IBM SmartCloud Application Performance Management.

The following cross-references are used in this glossary:

- See refers you from a term to a preferred synonym, or from an acronym or abbreviation to the defined full form.
- See also refers you to a related or contrasting term.

To view glossaries for other IBM products, go to [www.ibm.com/software/globalization/terminology](http://www.ibm.com/software/globalization/terminology) (opens in new window).

A

agent Software that is installed to monitor systems. An agent collects data about an operating system, a subsystem, or an application.

alert A message or other indication that signals an event or an impending event that meets a set of specified criteria.

application One or more computer programs or software components that provide a function in direct support of a specific business process or processes.

arithmetic expression A statement that contains values joined together by one or more arithmetic operators and that is processed as a single numeric value. See also arithmetic operator.

arithmetic operator A symbol, such as + or -, that represents a fundamental mathematical operation. See also arithmetic expression.

attribute group A set of related attributes that can be combined in a view or a situation. See also view.

C

capacity planning The process of determining the hardware and software configuration that is required to accommodate the anticipated workload on a system.

D

database (DB) A collection of interrelated or independent data items that are stored together to serve one or more applications.

data warehouse A central repository for all or significant parts of the data that an organization’s business systems collect.

DB See database.
event  An occurrence of significance to a task or system. Events can include completion or failure of an operation, a user action, or the change in state of a process. See also alert.

historical collection  A definition that is used to collect and store data samples for historical reporting. The historical collection identifies the attribute group, any row filtering you have assigned, the managed system distribution, frequency of data collection, where to store it for the short term, and whether to save data long term.

historical data management  A set of procedures that are applied to short-term binary files that send historical data to either a data warehouse or to delimited text files. Entries in the short-term history file that are over 24 hours old are deleted, which makes room for new entries.

interval  The number of seconds that have elapsed between one sample and the next.

managed system  A particular operating system, subsystem, or application in an enterprise where a monitoring agent is installed and running.

migrate  To move data from one location to another.

monitor  An entity that performs measurements to collect data pertaining to the performance, availability, reliability, or other attributes of applications or the systems on which the applications rely. These measurements can be compared to predefined thresholds. If a threshold is exceeded, administrators can be notified, or predefined automated responses can be performed.

monitoring agent  See agent.

monitor interval  A specified time, scalable to seconds, minutes, hours, or days, for how often the monitoring server checks to see if a situation has become true. The minimum monitor interval is 30 seconds; the default value is 15 minutes.
**P**

**parameter (parm)**
A value or reference passed to a function, command, or program that serves as input or controls actions. The value is supplied by a user or by another program or process.

**parm** See parameter

**performance**
A measure of a system's ability to perform its functions, including response time, throughput, and number of transactions per second.

**S**

**sample**
The data that the product collects for the server.

**V**

**view**
A window pane, or frame, in a workspace. It may contain data from an agent in a chart or table, or it may contain a terminal session or notepad, for example. A view can be split into two separate, autonomous views. See also attribute group

**virtual machine (VM)**
A software implementation of a machine that executes programs like a real machine.

**VM** See virtual machine

**W**

**workspace**
In Tivoli management applications, the working area of the user interface, excluding the Navigator pane, that displays one or more views pertaining to a particular activity. Predefined workspaces are provided with each Tivoli application, and systems administrators can create customized workspaces.
Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX  78758  U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurement may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.
If you are viewing this information in softcopy form, the photographs and color illustrations might not be displayed.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user, or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally identifiable information. If this Software Offering uses cookies to collect personally identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect each user’s name for purposes of session management, authentication, and single sign-on configuration. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect personally identifiable information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for notice and consent.


Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user, or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally identifiable information. If this Software Offering uses cookies to collect personally identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect each user’s name for purposes of session management, authentication, and single sign-on configuration. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect personally identifiable information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, See IBM’s Privacy Policy at [http://www.ibm.com/privacy](http://www.ibm.com/privacy) and IBM’s Online Privacy Statement at [http://www.ibm.com/privacy/details](http://www.ibm.com/privacy/details) the section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM

**Trademarks**

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

Adobe, PostScript and all Adobe-based trademarks are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

Intel is a registered trademark of Intel Corporation or its subsidiaries in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.
# Index

## A
- accessibility vii, 59
- agent deployment troubleshooting 54
- agent installation images merging 25
- preparing 25
- application monitoring deploying 24
- Application Performance Management UI overview 32
- applications monitoring 33

## B
- books
  - See publications

## C
- collected data managing 40
- collecting logs 54
- components 1
  - configuring historical data collection 39

## D
- Deploy Application Monitoring 17, 24
  - deploying application monitoring 24
  - monitoring for applications 24
  - OS monitoring agents 21
  - requirements for OS monitoring agents 19
  - virtual machine image for IBM Tivoli Monitoring 14
  - virtual machine image for Tivoli Data Warehouse 12
  - deploying an OVF template 12, 14
    - recover 28
    - deployment order 12
    - deployment roadmap 11
    - deployment sequence 12
    - deployments verifying 17
  - Discover Systems and Deploy OS Monitoring 17, 21
    - discovering results 22
    - systems 21

## E
- education
  - See Tivoli technical training

## G
- generating reports 44
- glossary 61

## H
- historical data collection
  - configuring 39
  - managing 39
  - historical reports 43
    - Tivoli Common Reporting 43
    - History Collection Configuration 39, 40

## I
- IBM SmartCloud Application Performance Management Entry Edition - VM Image
  - Overview 1
  - installation and deployment guide 29
  - installation and deployment roadmap 11
  - installation roadmap 11
  - IP addresses scanning 21

## K
- KCICF5100E 54
- KFWITM474E 57

## L
- Launch Pad 17

## M
- Maintain Appliance 17
- Manage Events 17, 34
- Manage Situations 17
- managing collected data 40
  - historical data collection 39
  - manuals
    - See publications
    - merging
      - agent installation images 25
  - Monitor Warehouse Agent Configuration 17, 41
  - monitoring applications 33
  - events 34
  - operating systems 33

## O
- offerings
  - components 1
- online publications accessing vii
  - ordering publications vii
- OS agent reports generating 44
- OS monitoring agents
  - deploying 21
  - deployment prerequisites 19
  - overview Application Performance Management UI 32
- Overview IBM SmartCloud Application Performance Management Entry Edition - VM Image 1

## P
- preparing
  - agent installation images 25
- publications
  - accessing online vii
  - ordering vii

## R
- reconfiguration 28
- recover deployment 28
- reports generating 44
- scheduling 45
- resource dimension table creating 44
  - populating 44
  - responding to events 35
  - roadmap
    - installation and deployment 11
    - upgrading a component 47

## S
- scanning
  - IP addresses 21
  - scheduling
    - reports 45

© Copyright IBM Corp. 2012, 2014
service 10
service management connect 10
SMC 10
support 10
systems
discovering 21
discovery results 22

t
Tivoli Common Reporting 43
Tivoli Documentation Central vii
Tivoli technical training viii
Tivoli user groups viii
training, Tivoli technical viii
troubleshooting
agent remote deployment failure 54
collecting logs 54

u
upgrading a component 47
user groups, Tivoli viii

v
verifying
deployments 17
View Application Availability and
Performance 17, 33
View Historical Reports 17, 44
View System Availability and
Performance 17
viewing
monitoring data 31
Tivoli Enterprise Portal 31
virtual environments
monitoring 37

w
warehouse agents
monitoring 41

Readers’ Comments — We'd Like to Hear from You

IBM SmartCloud Application Performance Management Entry Edition - VM Image
Installation and Deployment Guide
Version 7 Release 7

Publication No. SC27-5334-01

We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy, organization, subject matter, or completeness of this book. The comments you send should pertain to only the information in this manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any way it believes appropriate without incurring any obligation to you. IBM or any other organizations will only use the personal information that you supply to contact you about the issues that you state on this form.

Comments:

Thank you for your support.
Send your comments to the address on the reverse side of this form.
If you would like a response from IBM, please fill in the following information:

Name

Address

Company or Organization

Phone No.

Email address